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CHAPTER 1:  INTRODUCTION

Welcome

Welcome, and thank you for using Maptech's Offshore Navigator!

This document, condensed from Offshore Navigator's electronic Help system and formatted for efficient printing, is
designed to serve as an extensive printed reference for using Offshore Navigator.

However, please note:  This document is not a comprehensive reference.  The Help system that accompanies
Offshore Navigator software remains your best source of information about Offshore Navigator's features and
capabilities.  Documentation updates are made available for free download at www.maptech.com, so please check
in from time to time to ensure that you have the most up-to-date information on using Offshore Navigator.

Chances are good that if you cannot find the information that you need in this document, it will be found in the
electronic Help.  Click Help, Contents if you have any further questions.

Note for Offshore Navigator Lite Users:
This guide was written for the full version of Offshore Navigator.  The Lite version of Offshore Navigator contains a
reduced set of features.  Several of the program features described in this guide are NOT available in Offshore
Navigator Lite.  Sections that describe features found exclusively in the full version appear in lighter typeface.

Optional Full-Version Upgrade
The full version of Offshore Navigator provides more options and greater flexibility.  An upgrade to the full version
would let you:

• Create "Go To" routes.  A “Go To” is a quick way to set a direct course straight to one waypoint, in a
single step.  Once the waypoint is reached, the Go To is automatically deleted.  No need to sort through
the Route List or rename/store routes.

• Create a route in Offshore Navigator and follow it with your Autopilot.  Offshore Navigator will send
waypoints to your Autopilot; simply acknowledge each new waypoint in your Autopilot as you cruise.

• Record a track showing your vessel's progress.  The track may be used as a visual aid, or converted into
a route for navigational use if you want to retrace your path of travel.

• Set Position Marks at your vessel location whenever you want to mark where you were at a given time.
• Take advantage of On-Water Mode:  a simplified set of controls, reduced to just those tools that you

need most during navigation.  All other program features are kept out of your way behind the Plan mode
button--to use any other tools, just press Plan.

• Create Alarm Areas to trigger a warning beep if you enter or exit an alarm zone.
• Place Named Waypoints at major locations in your cruising area.  A single Named Waypoint may be used

in multiple routes.
• Send a Position Report via e-mail to anyone who needs to be kept informed of your location.  The report,

automatically generated by Offshore Navigator Lite, includes your vessel's latitude and longitude and a
chart image of your immediate surroundings.

• The full version of Offshore Navigator includes a built-in Ship’s Log, which lets you keep an official record
of your vessel position, course, speed and progress, and print this information for use as a paper
reference.

• The full version of Offshore Navigator also entitles you to free technical support by telephone.

The full version of Offshore Navigator is included with Maptech’s Digital ChartKit and Marine Navigator products.
For more information on upgrading, please visit www.maptech.com/upgrade.

What's New in 5.0x

If you're upgrading from a pre-5.0 version of Offshore Navigator, here are the new features and terms that you'll
notice:

http://www.maptech.com/


8

GPS Setup Wizard (new in 5.06)
An automated setup utility is now available to make configuring your GPS settings quick and easy.  Just click
Vessel/GPS, Setup, GPS Setup Wizard to run the Wizard.  The Wizard will automatically detect your GPS
manufacturer, model, and the port where it is connected to your computer, and will make the appropriate
configuration settings in Offshore Navigator.

Ship's Log (new in 5.02) (FULL VERSION ONLY)
An electronic logbook lets you keep a record of trips, conditions, and vessel operations.  Optional timed entries can
be made hourly or half-hourly, and entries are automatically logged to record specific events, like GPS signal loss
and triggered alarms.  See page 86.

On-Water Mode (FULL VERSION ONLY)
Designed to make navigation even simpler.  In On-Water Mode, the toolbar and controls that you need for
trip planning are replaced by a simple set of buttons, with the features you're most likely to need during
navigation.  With this simple interface, you can quickly find the tools you need, while keeping your
attention on your surroundings.  Press the On-Water button in the lower left corner of your screen to

enter On-Water Mode.  In On-Water Mode, press the Plan button to return to Plan Mode (Offshore Navigator's
standard operating mode.)  See Chapter 5, page 96.

Automatic Zoom/Scale Buttons (new in 5.01)
The pair of Plus and Minus buttons at the lower right corner of the Offshore Navigator screen
provide automatic zoom level/chart scale adjustment.  When you press the plus (+) button,
Offshore Navigator will either adjust your zoom level or automatically switch to a different chart,

whichever better provides a 50% closer view.  Pressing the minus (-) button does the same thing in reverse, for a
view that's 50% "farther away."

Spherical Horizon View (FULL VERSION ONLY)
An option in On-Water Mode (Chapter 5).  In Spherical Horizon View, charts are presented in a curved format, much
like a globe.  This lets you see your immediate surroundings in high details, while benefiting from a "look-ahead"
viewpoint of the chart area in your path.

Position Marks (FULL VERSION ONLY)
A classification of Marks.  Press the Position Mark button (or click Tools, Create Position Mark) to place
a Position Mark at your vessel location.  Position marks stay behind on the chart after your vessel icon
moves away.  They are handy for recording things you notice while you cruise, and for when you want to

make a quick note of where you were at a given time.

Streamlined Navigation Panel
Most of the basics are still here, plus a simple Plus/Minus zoom button control.  Data formerly contained in the
Status Bar (triggered alarms, datum status, Navigation Mode/Vessel positioning method) has now been
consolidated with the Navigation Panel, thereby making a little more room for chart image display.  See page 14 for
details.

A Direct Route is now a "Go To" (FULL VERSION ONLY)
In an effort to streamline and simplify some of Offshore Navigator's commands, we have made a few terminology
changes.

 A Direct Route is now a "Go To."  Notice the new toolbar button.

To View a Location on a Chart, Choose "Locate"
The Go To button previously found in many of Offshore Navigator's windows could sometimes get a little confusing.
Its purpose was straightforward—to show you the chart location of the highlighted overlay—but it didn't actually set
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a course for the location.  To avoid any confusion, this feature has been renamed Locate.  You'll notice this change
in both windows and menus.  (The Go To menu, for example, is now the Locate menu.)

Navigation Mode/Vessel Position Source
Instead of choosing Navigation Mode from the Vessel/GPS menu and then making your selection, you only need
to make one menu selection to start your vessel icon moving.  At the top of the Vessel/GPS menu, choose either
Position from GPS or Position from Simulator.  A check mark will indicate your choice.  Checking neither is the
same as choosing "None" for Navigation Mode in earlier versions of Offshore Navigator.  See page 56 for more
details.

Device Settings/Navigation Setup
GPS, Vessel, Autopilot, and Simulator Setup are now found under Vessel/GPS, Setup.

Transferring GPS Data to/from Computer
The GPS to Computer and Computer to Vessel/GPS menu items, for the transfer of stored coordinate date, are
now found under the File menu.  Choose File, Import Data from GPS or File, Export Data to GPS.

Configuration/Customization Options Under One Roof
As continuing upgrades added more and more features to Offshore Navigator, our customers found themselves
going to two places to adjust optional settings:  File/Preferences, and View/Options.  All adjustments are now made
by clicking View, Options.  Tabs organize all the settings.  Visit the new Options window to find familiar settings
and clarified text captions.

More New Terminology
"Geo Names" are now "Place Names."  Geo Names—place names classified by geographic feature type into a
searchable database—are more aptly called Place Names.  Choose Locate, Place Names to search for specific
places or feature types.

"Poly/Line" Alarms are now "Line/Shape" Alarms.  The feature itself hasn't changed:  you can still create
alarms in the shape of lines or multi-sided polygons.

Contour Charts (Additional chart control added in 5.01)
(For owners of Maptech Contour Charts:  3-D underwater topography.)
Viewing your contour chart coverage in split-screen has just gotten easier.  Just click Charts, Link to Contour
Chart, and the corresponding Contour chart will automatically open in a second window within Offshore Navigator.
If you have installed contour charts, a fourth tab appears in the View, Options window, so you can configure your
contour chart display.  A new, optional Contour Chart Control has been added for more precise chart manipulation.
(See page 48 for details on contour chart options.)
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Overview of Toolbar and Controls

Toolbar

Toolbar buttons may be shown in small or large.  The image below shows large buttons, each with a label.  For
large buttons, choose View, Options and under the General tab, check Large Toolbar Buttons.

  Man Overboard
Offshore Navigator is equipped with a Man Overboard tracking feature.  In case of such an emergency, press this
button and Offshore Navigator will mark the location and note the lat/lon, provide the range and bearing to the man
overboard, track the elapsed time, and calculate the time it will take to reach the man overboard from the current
vessel location.  See page 91.

  Locate Vessel
If your vessel is not visible on the screen and you want to go to its location, press the Locate Vessel button and
Offshore Navigator will center the chart window on your vessel.  (You can also choose Locate Vessel from the
Vessel/GPS menu.)

  Chart List
Press this button to view the list of available charts and select one for display.  (You could also click File, Open
Chart, or Charts, Chart List.)

  Max Detail
Automatically switches to the largest-scale (most detailed) chart available for the area you're viewing.  (See page
18 for more information about different scales of charts.)

  Scale In
Opens the next available chart of a larger scale, for the area you're viewing.  This lets you get a more detailed view.
(Larger-scale charts cover less area, but provide greater detail.)
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  Scale Out
Opens the next available chart of a smaller scale, for the area you're viewing.  This is a bit like zooming out to get a
better overall view of the area.  (Smaller-scale charts cover more area, at a lesser level of detail.)

  Print
A one-step way to print the chart area you're viewing on the screen.  The printout will include the chart name and
ID, its corner coordinates, and lat/lon rulers around the edge of the page.  See page 42.

  Cascade
If you have several windows open, this will arrange them in a cascade pattern on your screen, so you can read each
one's title bar.

  Tile Vertically
Automatically arranges open chart windows side by side on the screen.

  Tile Horizontally
Automatically arranges open chart windows one above the other so that they are sharing equal screen space.

  Drag/Pan Tool
The usual cursor tool, and the main way of moving around the charts.  This tool is automatically selected when you
start Offshore Navigator, letting you click on the chart and drag it in any direction.  You can also right-click on
overlays (routes, waypoints, etc.) to get more information about them.

  Create "Go To" (FULL VERSION ONLY)
Lets you create a route that starts at your vessel and contains only one waypoint (the route's end).  This feature is
designed to efficiently set a course from your current position straight to the desired location.  See page 21.

  Create Route
A route is a series of locations (waypoints), connected in sequence.  On a chart, a route is shown as a series of
waypoint symbols connected in order by straight line segments.  Select the Route tool, then click on the chart to set
waypoints along your intended course of travel.

  Mark
Lets you add symbols to the chart, by clicking on the chart.  You can choose from several symbols and colors, and
assign names to your marks.  See page 134.

  Position Mark (FULL VERSION ONLY)
Places a mark at your vessel location.  The mark symbol remains in place on the chart even after your vessel has
moved away.  This is handy for keeping track of where you were at a particular time.  The date and time of creation
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is automatically recorded with each Position Mark.  A Position Mark looks just like regular marks, but is indicated in
the Mark List by an asterisk (*).  See page 134.

  A2B Measurement
A measurement tool, designed to let you find the range and bearing between two points that you designate.  Click
on the chart to set point A, then click again elsewhere to set point B.  Right-click on either point and choose
Properties to find range and bearing.

  Annotate
Lets you add notes to the chart.  Click this button, then click on the chart where you want to add a note.  You can
type up to 256 characters (they will appear on one line).

  Anchor Alarm (FULL VERSION ONLY)
Sets an alarm to notify you if the vessel drifts beyond expected range after anchor is set.  You can specify the
maximum acceptable range, controlling the conditions that trigger this alarm.

  Line/Shape Alarm (FULL VERSION ONLY)
An alarm is an area you define on a chart, so that Offshore Navigator can warn you when your vessel enters or
leaves that area.  The Line/Shape alarm button lets you delineate alarm areas.  For example, you might set an
alarm around an area of shallow rocks, and ask Offshore Navigator to warn you if you enter that alarm zone.  Or,
you can delineate an area where you'd like to fish, so that Offshore Navigator can warn you if you drift beyond the
boundary you set.

  Zoom In
Click on this toolbar button, then click on the chart to zoom in closer, by one zoom level.  The point where you
clicked will be centered on the screen.

  Zoom Out
Select this tool, then click on the chart to zoom out by one zoom level.  The point where you clicked will be centered
on the screen.

  Maptech MapServer
Press the Maptech button on Offshore Navigator's toolbar to go to the Maptech MapServer at www.maptech.com
(Internet connection required).
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  Help
Opens Offshore Navigator's electronic Help document to the Table of Contents page.  The Help menu (on Offshore
Navigator's menu bar) also provides links to the Help system, as well as additional documentation and data.

  Autopilot (FULL VERSION ONLY)
If you have an Autopilot aboard your vessel, use this button to start sending course data to the Autopilot when
navigating.

Chart Status Bar

This panel, called the Chart Status Bar, lets you control various settings for how the active chart is displayed.  (The
active chart is the chart that you're viewing or working with.  If you have more than one chart open, you can tell
which one is active by its highlighted title bar.)  You can adjust zoom level, chart rotation, and how the chart is
presented in relation to the vessel icon.  A quick glance at this Chart Status bar tells you the current settings, as
well as the chart scale and the width of the area it covers.

Follow Vessel
When this box is checked, the chart display will follow the vessel as it moves across the charts.  This means that
your vessel can't drift out of view, since the chart image will update itself to keep the vessel always visible on the
screen.

 Relative:  The vessel stays in the center of your screen, while the chart "moves" underneath.
 True:  The vessel moves across the chart, and the chart only scrolls itself when the vessel nears the edge

of the screen.
 Look Ahead:  Works like Relative, but keeps the vessel at the screen's edge, to maximize your view of

chart area ahead in your vessel's path.  The chart scrolls while the vessel stays in the same place on your
screen.

Link Charts
When this option is checked, you can link to another chart that shares the same center lat/lon as the current chart.
When two (or more) charts are linked, they can be viewed together.  They will scroll simultaneously, and any
overlays (like markers or routes) that you create on one chart will automatically appear on the other chart as well.

Chart Orientation
These options refer to the way the chart image is positioned on your screen.

 Chart Up:  The chart image is oriented so that whichever edge was the top of the paper original is at the
top of your screen.

 North Up:  True North is straight "up" on your screen.  (For most charts, this will be the same as Chart
Up, but some paper charts were drawn with North facing in another direction.)

 Course Up:  The chart rotates as necessary so that the vessel always points and/or moves towards the
top of the screen (when following a route or in Simulator mode).

NTM Status
(For subscribers to Maptech's Chart Update Service)
The date that this chart was last updated with Notice-to-Mariners corrections.
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Chart Width
The width of the geographic area being shown on the screen (in the active chart window).  If you zoom in or make
the window smaller, this figure will decrease.  If you zoom out or enlarge the window, the figure will increase.

Chart Scale
The scale of the active chart.

Zoom Level
The zoom level at which you are viewing the active chart.

Navigation Panel

The Navigation Panel provides information about the chart you're viewing:  the name, chart ID, and scale of the
chart, and the lat/lon of your cursor position.

Enter On-Water Mode (FULL VERSION ONLY)
Puts Offshore Navigator into On-Water Mode, replacing menus and controls with a simpler set of buttons.
(See Chapter 5:  On-Water Mode, on page 96.)

Scale Selector; info on active chart

The row of colored rectangles on the left represents other charts available for the area you're viewing.  They are
arranged in order of scale, from large-scale at left to small-scale (less detailed) at right.  The light-shaded rectangle
represents the active chart.  Green represents a topographic map, and red represents a Navigation Photo.  The
name, scale, zoom level and chart ID of the active chart are given.  When you hold your cursor over each rectangle,
that chart's name, scale and ID number are displayed.  To switch to a different chart, just double-click on a
rectangle.

Cursor Position Data
Gives the lat/lon of your cursor's position.  Also gives the range and bearing from your
vessel location to the point where your cursor is.

Zoom in/Zoom out
Press the Plus button for a closer view; press the Minus button for a wider view.  Offshore
Navigator will either adjust the zoom level at which you’re viewing the chart, or switch to a
different chart entirely—whichever is closer to a 50% adjustment.

When you first start using Offshore Navigator, the plus and minus buttons are set to adjust EITHER the zoom level
or the chart scale.  If you prefer, you can set the buttons to adjust zoom level ONLY, or scale ONLY.  To adjust this
setting, click View, Options and select the General tab.
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CHAPTER 2:  GETTING STARTED (THE BASICS)

Opening Charts:  The Chart List

All charts available for viewing are listed in the Chart List.  There are several ways you can open the Chart List:

• Press the Chart List button on the toolbar.

  Chart List button.

• From the File menu, choose Open Chart.

• From the Charts menu, choose Chart List.

Note:  If you are reading charts from a CD, be sure the CD is present in your drive.  (If it's in the drive, but the
charts aren't listed in the Chart List, click Charts, Change CD/Refresh Chart List.)

From the resulting list, double-click on the title of the chart you want to open.  (For more about charts and the
Chart List, see page 34.)

Moving Around the Charts

Dragging and Scrolling
The Drag Tool, represented by a small hand symbol, is the main way of repositioning the chart.  (The drag
tool is the default cursor tool, so it is already selected each time you start Offshore Navigator.) Left-click
anywhere on the chart and drag the chart to move it.

When you hold the cursor near the edge of the screen, it changes to a small black arrow.  Hold down the left mouse
button and the chart will scroll smoothly in the direction of the arrow.  If you hold the cursor in a corner, the arrow
will point diagonally.

 

To shift the chart area by half a screen in any direction, hold the cursor at the edge of the screen until the edge
arrow appears, and then double-click.
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Using the Overview Window

The Overview Window is a smaller, separate window that appears as an inset in a corner of your screen.  It shows a
thumbnail overview (extremely zoomed-out view) of the chart on display in the main window.  A small red rectangle
represents your screen, enclosing the area that is being shown in the main window.  You can use the cursor to click
and drag this red rectangle to any part of the Overview, and the desired area will appear in the main window.  This
is handy for quickly moving to a distant portion of a chart.

Zooming In and Out

You can view your charts at up to seven different zoom levels.  There are several ways to zoom in and out on your
charts.

 Toolbar buttons:  Click on either button to select that tool, then click anywhere on the chart to zoom
in/out one level.  The point you click will be centered on the screen.
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 View menu:  Select Zoom In or Zoom Out from the View menu, then click on the chart.
 Right-click on the chart and choose Zoom In or Zoom Out.
 Use the plus and minus buttons in the navigation panel at the bottom of your screen.  Plus zooms in,

minus zooms out.

Different Scales of Charts

Chances are good that you have more than one chart for the same general area, at different scales.  You can switch
to a different-scale chart for the area you're viewing.  There are several ways to change scales:

 Toolbar:  Click on either the Scale In or the Scale Out button to switch to the next available chart (the
chart whose scale is closest to the current chart).  Click on the Max Detail button to go straight to the
largest-scale chart (the most detailed scale) available for the area you're viewing.

 View menu:  Choose Scale In, Scale Out, or Max Detail from the View menu.
 Right-click on chart:  These commands are also available when you right-click on a chart.
 Use the scale control:

Each colored rectangle represents a chart available for the area you're viewing.  Hold the cursor over a
rectangle to see that chart's name, ID and scale.  Click on a rectangle to switch to that chart.

Automatic Zoom/Scale

As mentioned, there are toolbar controls specifically designed for zooming in and out on the
chart you're viewing, and other controls designed to let you switch to a different chart whose
scale shows a closer or wider view.  The Plus and Minus buttons on the Navigation Panel

combine both these features in a single control.

When you press the plus (+) button, Offshore Navigator will move you in closer by a factor of approximately
50% (for roughly twice as close a view).  Press the minus (-) button to move farther out from the chart, also by
a factor of approximately 50%.  This will let you see more area on the screen.  In each case, the point at the
center of your screen will remain the same.

In adjusting your view, Offshore Navigator will either zoom in/out on the current chart, OR switch to a chart of
a different scale.  This depends on the zoom level at which you are already viewing the chart, and on the
availability of other charts for the area.

For example, if you are viewing a chart at close zoom, you might be better off switching to another chart scale,
instead of trying to zoom in further on the same chart.  In this case, Offshore Navigator will open a larger-scale
chart whose scale best approximates a 50% closer view.  (A larger-scale chart covers less area, but provides
greater detail.)  In other cases, a 50% closer view may be best obtained by zooming in on the chart that's
already open.

If you prefer, you can set the plus and minus buttons to adjust zoom level ONLY, or scale ONLY.  To adjust this
setting, click View, Options and select the General tab.

Limit of Plus (+) button
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For areas where you do not have detailed chart coverage, Offshore Navigator will zoom in to the maximum
usable zoom level on the most detailed chart available.  If the plus button is grayed out, this means you have
already attained the closest view possible for that area.

Limit of Minus (-) button
The smallest-scale chart available is the Maptech World Chart.  Zooming out on the World Chart provides the
widest available chart view for any area.

Linking Two Charts for One Location

You may already know that if you want to open another chart for the area you're viewing, you can click Charts,
Charts at This Location and select from a list of charts available for the location you're viewing.  If you want to be
able to view two charts for the same lat/lon, AND have both charts move/scroll together at the same time, you can
link the two charts.

To do this, use the Charts menu and choose Link Two Charts at Location.  A modified Chart List window will
appear, listing only those charts that cover the lat/lon of the point at the center of your screen.  Highlight a chart
title and press Open Chart, and the two charts—your original chart plus the one you just opened—will appear side-
by-side on the screen.  Whenever you scroll or drag one chart, the other chart will follow so that both charts are
always centered on the same lat/lon.  (Check the Auto Adjust Zoom checkbox in the chart list and Offshore
Navigator will automatically present the chart at the same zoom level as the chart you were already viewing.)

This lets you view different chart scales for the same area, or view different types of coverage (nautical chart and
topographic map, for instance).

Below is a sample of two linked charts—notice that the center of each chart image shows the same geographic
location.
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The Vessel

Whether you're planning a trip or already on the water, Offshore Navigator helps you predict or control your
vessel's course.  A special symbol is used to represent your vessel.

 

Positioning the Vessel
If your GPS is on and connected, the vessel will be placed at the lat/lon reported by your GPS.  You can also
position the vessel at any point on the chart, by right-clicking on the chart and choose Put Vessel Here.

Locate Vessel
To find the vessel's location and display the chart containing the vessel, use the Locate Vessel command
(click the Locate button on the toolbar, or choose Locate Vessel from the Vessel/GPS menu).
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Creating Routes, Setting Course

Offshore Navigator lets you set waypoints on the charts, to mark your destination and planned course of travel.
Once you tell Offshore Navigator where you plan to go, Offshore Navigator can provide useful data to help you keep
to the plotted course.

"Go To" Feature (FULL VERSION ONLY)

For a direct route to a single destination, create a Go To.   A Go To always starts at your vessel, and contains only
one waypoint.  (This is modeled after the "GOTO" navigation feature provided by most GPS units.)  Use a Go To
when you want to go directly to a particular location.

 

There are three ways to create a Go To:

• Click the Create Go To toolbar button, OR-

• Choose Create Go To from the Route menu, OR-

• Right-click on a chart and choose Create Go To.

A line appears on the chart, starting at your vessel.  The cursor turns into the waypoint symbol.  Move the cursor to
the location you'd like to go, and click to set the waypoint on the map.  (If you know the lat/lon of your destination,
right-click and choose Key in Lat/Lon, then type the desired coordinates.)

Routes

If you use a GPS, you are already familiar with routes and waypoints.  A route is a series of locations
(waypoints), connected in sequence.  On a chart, a route is shown as a series of waypoint symbols connected in
order by straight line segments.

To create a route:
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 Click the Route button on the toolbar, OR-
 Choose Create Route from the Route menu, OR-
 Right-click on a chart and choose Create Route.

Then, click on the chart where you want to set a waypoint.  As you click, waypoint symbols are added to the chart
and are automatically connected with lines.  When you have reached the end of your route and set your final
waypoint, right-click and choose Save.  The cursor changes back to the Drag tool (hand symbol).

To Move a Waypoint
To move a waypoint, hold the cursor over the waypoint until the cursor changes to a cross shape.  Then you can
click and drag the waypoint to a new location.

To Delete a Waypoint
To delete a waypoint, right-click on it and choose Delete this Point.

To Add a Waypoint
Hold the cursor over the route, and when the cursor changes to a cross shape, right-click.  Choose Insert
Waypoint at End, at Beginning, or in Line.  (If you choose Insert in Line, the waypoint will be placed at the
portion of the route where you placed the cursor.  The Insert in Line option only appears when you right-click over
a leg of the route- that is, on the line between two waypoints.)

If you know the lat/lon where you want to place a waypoint, right-click and choose Insert Waypoint at End or at
Beginning, then when the cursor changes into the waypoint-adding symbol, right-click again and choose Key in
Lat/Lon.  Type the desired coordinates in the window provided.

You can change the route name, waypoint symbol and color, line color, etc., and add notes about a route, in the
Route Properties window.  Right-click on a route and choose Route Properties to edit the route.
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Following a Route, with GPS

If you use a GPS unit aboard your vessel, you can connect your GPS to Offshore Navigator and see your current
vessel position and movement on the charts.

When you install Offshore Navigator software on your computer, the Setup procedure includes a GPS Setup Wizard.
The Wizard automatically detects your GPS unit, determines its make and model, and configures Offshore
Navigator accordingly.  If you skipped the GPS Wizard during initial software setup, you can run it anytime by
clicking Vessel/GPS, Setup, GPS Setup Wizard.

To start communication between Offshore Navigator and your GPS, choose Vessel/GPS, Position from GPS, and
your GPS will tell Offshore Navigator where you are.  Offshore Navigator will move the vessel icon to indicate your
present location, using position data received from your GPS unit.  This creates a visual reference so you can
immediately see if you need to make corrections to stay on course.

If your vessel is equipped with an Autopilot, you can follow a route using Autopilot (see page 112).  You can also
use the Simulator to experiment with following routes under different current conditions and vessel speed/heading
(see page 111).  This lets you see what type of course correction would be required under various conditions,
which you specify for each simulation.  See page 84 for more about the Simulator.

Keeping the Vessel in View

To keep the vessel in view on your screen, just check the Follow Vessel checkbox at the bottom of the chart
window.  When this is checked, the screen automatically "follows" the vessel icon as it moves.  This means that
your vessel can't drift out of view:  the chart image will update itself to keep the vessel always visible on the
screen.  This is especially handy when following a route.

Specify Chart-Vessel Orientation
Once you check Follow Vessel, you have three chart-vessel orientation options:

 Relative:  The vessel stays in the center of your screen, while the chart "moves" underneath.  (This is
Offshore Navigator's default orientation.)

 True:  The vessel moves across the chart, and the chart only scrolls itself when the vessel nears the edge
of the screen.

 Look Ahead:  Works like Relative, but keeps the vessel at the screen's edge, to maximize your view of
chart area ahead in your vessel's path.  The chart scrolls while the vessel stays in the same place on your
screen.

Remember, in order for the icon to move, you must check either Position from GPS or Position from Simulator
from the Vessel/GPS menu.  See page 56 for more details.
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Automatically Follow Vessel
To automatically start following the vessel once you bring your vessel icon into view, choose View, Options,
General and check Follow Vessel upon Locate Vessel command.

Monitoring Your Progress with Data Windows

Data windows are designed for quick reference during navigation.  The data window panel may be dragged to any
area on your screen.  Each data window displays a different piece of information—you specify what information you
want to see.

Turning Data Windows On and Off
To bring data windows into view, check the Data Windows option on the View menu.  Uncheck it to turn data
windows off.

Configuring Data Windows
To configure your data windows, choose Vessel/GPS, Setup, Data Windows (or just right-click on the data
windows themselves).  There are several kinds of data that you can select for display.  See page 65 for more
information about using data windows, including a list of available data values.
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Creating Marks

Offshore Navigator lets you add symbols to indicate points of interest on the
charts.  These symbols are called Marks.

Creating a Mark
Press the Mark toolbar button, or click Tools, Marks, Create Mark,
and then click on the chart at the point you'd like to mark.

Position Marks (FULL VERSION ONLY)
Position Marks are marks you place at your current vessel
location.  The position mark stays behind on the chart after the

vessel icon moves away.  Position marks are handy for  recording things you notice while you cruise,
and for when you want to make a quick note of where you were at a given time.  In the Mark List, a Position Mark is
indicated by an asterisk (*).

To place a mark symbol on the chart at your vessel location, press the Position Mark toolbar button (or click
Tools, Create Position Mark).

Changing Symbol, Color, Etc.
To change settings for how all your marks should look, click
Tools, Marks, Mark List, and select the Setup tab.   Several
symbols are available.  To make changes to one mark at a time,
right-click on the mark symbol and choose Properties.

Searching for a Specific Mark
Click Locate, Marks to find any mark's location on the chart.

Locating Points of Interest

Searching by Place Name

Your Maptech Digital ChartKit may provide  an extensive database of Place Names and their chart locations,
classified by type.  The Place Names database saves you the trouble of scrolling around a chart in search of a
particular point.  Instead, you can type a keyword and search specific categories of locations:  canals, bays,
harbors, summits, rivers, reservoirs, etc.  These places and categories are taken from the Geographic Names
Information System (GNIS) developed by the US Geological Survey (USGS).  Offshore Navigator keeps track of
each location's coordinates, so that it can instantly display the chart coverage for any location you select.
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To search for a name, click Locate, Place Names, then type a
word (or portion of a word) in the Search window.  You can also
scroll through the Place Names list, or rearrange the order of
Place Names by double-clicking on any of the headings (Name,
Feature type, Lat, Lon).  When you have found your point of
interest, press OK and Offshore Navigator will take you to that
chart location, marking the location for easy identification.

Marine Facilities Search

Your Maptech Digital ChartKit may also provide  a Marine Facilities database, which works the same way as the
Place Names database.   See 105 for instructions on setting up your Marine Facilities search options.
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Setting Your Personal Preferences

Click View, Options to adjust your personal preferences for how your charts and data should be presented.  The
Options window lets you adjust the look and feel of how Offshore Navigator operates.

Chart Display Options

Chart Color Scheme
Six different color palettes are available, all designed to make the charts and controls easier to see in different light
conditions.  Experiment to find the options that work best for you.  Note:  This setting will affect your screen
display for ALL programs, not just Offshore Navigator. Not available for Windows XP "theme".

Bearings
Choose whether you would like your bearings displayed in Magnetic North or True North.  This setting applies to all
readings and calculations in Offshore Navigator.
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Datum
Choose a datum in which Offshore Navigator should display lat/lon.  Choose WGS84 and all lat/lons will be given in
WGS84 datum.  Choose Local and Offshore Navigator will display coordinates in whatever datum was originally
used to create this particular paper chart.  (You can find out a chart's datum by right-clicking on the chart and
choosing Chart Information.)

Linear Units
Linear measurements can be given in nautical (nautical miles and feet for distance, knots for speed), statute
(statute miles and feet for distance, miles per hour for speed), or metric units (kilometers and meters for distance,
kilometers per hour for speed).  This setting affects all windows or readouts where data is displayed or entered.

Lat/Lon Format
Offshore Navigator can display latitude/longitude readings in four ways:

Degrees Minutes Seconds (DDº MM' SS")
This coordinate system displays locations in Degrees, Minutes, and Seconds.  For example, in Deg.
Min.  Sec.  the location of Maptech's New Hampshire office would look like this:
43º 02' 08" N 070º 50' 36" W

Degrees and Decimal Minutes, carried out three decimal places:  (DDº MM.mmm')
This is the default coordinate system in Offshore Navigator and is commonly used with GPS
systems.  It is like Deg.  Min.  Sec.  except that the seconds are replaced by fractions of minutes
(the digits to the right of the decimal point).
Maptech's NH Office Location:
43º 02.141' N 070º 50.596' W

Degrees and Decimal Minutes, carried out four decimal places:  (DDº MM.mmmm')
The same format as the previous example, but carried out one more digit for more specific
readings.
Maptech's NH Office Location:
43º 02.1411' N 070º 50.5957' W

Degrees/Minutes and Decimal Minutes (DDMM.mmm')
This is just like Degrees and Decimal Minutes, except that there is no space between the degrees
and the whole minutes.  The minutes are carried out to the third decimal place.
Maptech's NH Office Location:
4302.141 N 07050.596 W

Default Zoom Level
When you first open a chart, it will be presented at whatever zoom level you select here.

 1x:  100%, or 1:1 zoom (original image)
 2x:  50%, or 1:2 zoom.
 4x:  25%, or 1:4 zoom.
 8x:  12.5%, or 1:8 zoom (maximum zoom-out)
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Chart Outlines
Chart Outlines are black, rectangular outlines that indicate areas covered by larger-scaled Maptech charts.  To find
out the chart's ID and scale, hover the cursor over any corner of the outline.  This highlights the outline in green for
easy visibility, and the chart's ID and scale are displayed in a small popup window.  To open the chart, double-click
the outline's corner.

Chart Outlines are shown on the World Chart and in any other area for which larger-scaled charts are available.

Chart Outlines.

Index Outlines
Like Chart Outlines, Index Outlines are rectangles that indicate areas covered by Maptech charts.  While Chart
Outlines indicate charts that you already own, Index Outlines show chart coverage that is available from Maptech,
but not installed on your system.  Index Outlines let you see what other charts are available for a particular area of
interest.  Index Outlines are color-coded by region, so you can discern each ChartKit region's coverage area.

Chart Scrolling
When you hold the drag tool near the edge of the screen, the cursor changes to an arrow symbol.  By holding down
the left mouse button, you can scroll the chart.  Use this lever to control the speed at which charts are scrolled.

If you don't want the cursor to change into the scrolling arrow when placed at the screen's edge, uncheck the Chart
Scrolling checkbox.

Note:  Another way to increase scrolling speed is to try switching to 16-bit color (decreasing color resolution from
32-bit to 16-bit).  Use the Windows Control Panel to adjust this Display setting (from the Start menu, choose
Settings, Control Panel, Display, Settings, Colors).  You may also try 256 Colors if necessary.

Chart-to-Chart Linkage
Offshore Navigator allows you to link charts:  simultaneously display two or more charts that have a common
lat/lon location.  This lets you view different chart scales for the same area, or view different types of coverage
(nautical chart and topographic map, for instance).  As you move the chart with your mouse in one window, the
chart in the linked window will automatically scroll to mirror that movement.
Link by Lat or Lon:  Allows you to link two topographic maps that share EITHER the same latitude OR the same
longitude.  (IMPORTANT:  For safety reasons, it is NOT recommended that you use this linking method for two
nautical charts.)
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Automatically Link Charts that Share a Lat/Lon:  This setting affects the charts you open from the Navigation
Panel.  When this option is checked, clicking on another chart rectangle in the Navigation Panel will open that new
chart in an additional window.  To view the two linked windows together, press the Tile Vertically or Tile
Horizontally toolbar buttons.

Overlay Options

Overlays
If your chart image is getting too "cluttered" with overlays, uncheck any of these options.  All overlays of the
type(s) you check will be removed from view.

Chart Notes
Chart Notes are text notes made by the cartographer in creating a particular chart.  A Note might refer to areas
where special caution is needed, or it might draw your attention to some important data.  To read a list of all Notes
on the chart you're viewing, click Charts, Chart Notes.  You can then click on any Note to read it in full.

The chart image itself may include text captions to indicate some of the areas
mentioned in Notes, but usually there are several areas that are not specially marked
on the charts.  Offshore Navigator can mark ALL note areas with "See Note" icons, to
draw your attention to each area.  You can either click Charts, Chart Notes to find a
particular note, or you may hover the cursor over any "See Note" icon and the
corresponding Note text will appear in a popup window.
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If you would like to remove these "See Note" icons from view, click View, Options, Overlays and under Pilot Aids,
Chart Notes/"See Note" icons, select none.  (Even though the area won't be marked by a "See Note" icon, you can
still hover the cursor over a Note area to read the related note.)

NTM Icons
(For subscribers to Maptech's Notice-to-Mariners Chart Update Service)
Locations of Notice to Mariner updates can be marked by red circles on the charts.  Check this option to display
these NTM icons and/or include the NTM labels.

NTM Chartlet Grids
(For subscribers to Maptech's Notice-to-Mariners Chart Update Service)
Areas that include one or more NTM changes can be marked off by NTM chartlets:  yellow rectangular grids.  (This
feature is useful when applying corrections to your paper charts, helping identify the chart areas over which the
new chartlets should be pasted.)

Tide Station Icons
Maptech ChartKit CDs edition 3.0 and higher contain extra data on tide measurements at specific  points, called tide
stations.  Tide tables are available for each tide station, so you can predict tides many months in advance.

These stations can be marked by icons on the charts.  The icons’ appearance changes to indicate whether the tide is
ebbing or flooding, and the icons also note the approximate maximum tide height at each station.

Under Tide Station Icons, choose whether to include icons and/or their labels on the charts.  (The label appears
underneath the icon and tells the station name.)

Current/Tidal Stream Station Icons
Maptech ChartKit CDs edition 3.0 and higher include extra data on current speed and direction measurements,
taken at specific points called current /tidal stream stations.  (For charts produced by the British Admiralty, the
preferred term is tidal stream.)  These stations can be marked by icons on the charts.

The icons’ appearance changes to show whether the current is ebbing or flooding.  Right-click on an icon to view the
current table and information about each current station.

Under Current Station Icons, choose whether to include icons and/or their labels on the charts.  (The label
appears underneath the icon and tells the station name.)
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General Options

Confirm Before Deleting
Check Confirm Before Deleting, and every time you tell Offshore Navigator to delete something (a marker or
route, for example), you’ll be asked if you're absolutely sure before Offshore Navigator actually deletes the item.
This is a good safeguard if you're afraid you might accidentally delete something important.

If you would rather not be prompted to confirm your decision each time you delete something, uncheck this
checkbox.

Large Toolbar Buttons
For help distinguishing the different toolbar buttons.  The buttons are enlarged and labeled.  (The example button
pictures throughout this Help system are all shown in Large format.) If you don't need large buttons, turn this
option off to gain a little more chart-viewing space.

Automatically Start Program upon Insertion of Chart CD in Drive
Check this box, and Offshore Navigator will automatically start whenever you insert a Maptech ChartKit CD in your
CD drive.

Following Vessel
Check here and the chart display will "follow" the vessel as it moves, so that the vessel icon is always visible on the
screen.  If your vessel leaves the area of the chart you're viewing, Offshore Navigator automatically opens an
adjacent chart.
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Follow Vessel upon "Locate Vessel" Command:  Check here if you want to automatically Follow the vessel
whenever you give the Locate Vessel command (see page 20).

Allow Temporary Scrolling away from Vessel:  Checking this option lets you scroll away from the vessel icon
(even though Follow Vessel is checked), and gives you a few seconds to look around before the screen view
returns to the vessel.  This option is handy because it lets you explore nearby chart areas, while still keeping an eye
on your vessel location.

Plus/Minus Buttons
The Plus and Minus buttons on the Navigation Panel allow you to adjust zoom level and/or chart scale.  Changing
zoom level means changing the magnification of the chart you're viewing.  Changing chart scale means switching to
another chart entirely in order to get a more detailed/wider view.

You can choose whether the buttons should affect zoom level only, chart scale only, or whether the buttons
should automatically "decide" whether to change zoom OR scale.  If you choose this last option, Offshore
Navigator will do whatever better represents a 50% adjustment in your chart view.  Sometimes this will mean
zooming in/out on the same chart, and sometimes you'll be switched to another chart scale.  In either case, the
chart image will automatically be centered on the point of interest.

Note:  The plus/minus buttons in the Navigation Panel aren't the only buttons you can use for zooming and scaling.
They're just the only buttons that you can configure for either function.  The toolbar along the top of the Offshore
Navigator window offers dedicated zoom and scale buttons, and you can also right-click anywhere on a chart and
choose zoom/scale options from the popup menu.

Automatic Chart Selection
When the Follow Vessel checkbox (bottom of chart window) is checked, the screen "follows" the vessel as it moves,
so that the vessel icon is always visible.  If your vessel leaves the chart that you're viewing, Offshore Navigator
automatically opens an adjacent chart.

Open Most Detailed Chart Available:  When you reach the edge of one chart, Offshore Navigator will always
open the largest-scale (most detailed) chart available for the area you have entered.

Always Open Same Chart Type (as previous):  Whenever Offshore Navigator opens an adjacent chart, it will
always be of the same type you're already viewing.  (For example, if you are viewing your vessel location on a
Navigation Photo, checking this option will cause Offshore Navigator to open only Navigation Photos as it follows the
vessel's progress.)

Always Open Nautical Chart:  In following the vessel on its course, check here if you want Offshore Navigator to
open and display only nautical charts (i.e.  no topographic maps, no Navigation Photos, etc.).   (See Chapter  for
more about different chart types.)

Contour Chart Options

If you have installed contour charts, a fourth tab appears in the Options window.  For more information on contour
charts, see page 46.
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CHAPTER 3:  CHARTS

The Chart List

The Chart List shows all charts immediately available for viewing.  To view the Chart List, press the Chart List
button, or click Charts, Chart List.

To open a chart, highlight the title and press Open Chart (or simply double-click the chart title).

Refresh the Chart List Whenever You Insert a CD
The Chart List may include charts on a CD or charts stored on your hard drive.  If you are viewing charts from CD,
then any time you insert a chart CD while Offshore Navigator is running, you must refresh the Chart List.  Click
Charts, Change CD/Refresh Chart List, or press the Refresh button in the Chart List window.  This will tell
Offshore Navigator that you have inserted a new CD, and Offshore Navigator will scan the CD and add those charts
to the Chart List, so they will be available for use.

Rearranging the Order in which Charts are Listed
You can arrange charts in order by ID, Name, Type, Scale, or any other heading (see below for information on
columns that aren't visible in the graphic on this Help page).  Simply click the heading at the top of the column, and
the chart list will rearrange itself automatically.
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For example, to place all the charts in alphabetical order, click on the Chart Name heading at the top of the chart
name column.  This will arrange the charts in order from A to Z.  To reverse the order (that is, to list charts from Z
to A), simply click on the Chart Name heading again.

Information Shown for Each Chart:
In addition to the Chart ID, Name, Type and Scale (as shown in the graphic above), there are several other
pieces of information available for each chart in the list.  Use the scroll bar along the bottom of the chart list window
to find the following types of information:

• Rev Date:  The date when this chart was last revised.  (See Edition, below.)
• Prod Date:  This field is available for certain kinds of data only.  It indicates the date the chart or map was

created.
• Edition:  The edition number of this chart.  (For example, as NOAA chart coverage of a particular region is

revised over time, a new edition is printed after each revision.)
• NTM Edition:  If any Notice to Mariner changes have been applied to this chart, the edition of the most

recently applied changes is given here.
• Agency:  The agency that created the original paper chart that was scanned into electronic format.
• Mag Var:  The magnetic variation for the chart.  (magnetic variation is the number of degrees by which

Magnetic North differs from True North.  This figure changes depending on location.)
• Full Path:  Gives the precise directory location of this chart (whether it is on a CD or hard drive).

Chart Management Options (other tabs in this window)
Other Chart Management options are available, from different tabs in the window pictured above.  You can copy
charts to your hard drive, and use the Advanced Chart Management options to manage your chart storage.
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Copying Charts to Hard Drive

Offshore Navigator offers you several Chart Management options, including the ability to copy charts to your hard
drive.

Why Copy Charts to My Hard Drive?
Copying charts to your hard drive provides faster display capability.  It also saves you the need of keeping CDs on
hand, and the trouble of switching them in and out of your CD drive.  If there are charts you plan to use frequently,
you’ll probably want to copy them to your hard drive.  This window is designed to let you do this quickly and easily.

Copying Charts:  Step by Step
1. Insert a Maptech chart CD in your CD drive.
2. From Offshore Navigator's Charts menu, choose Chart List.
3. Select the Copy Charts to Hard Drive tab.
4. If the charts on the CD do not appear in the "Charts on CD" list on the left, press the Change CD/Refresh

Chart List button and the charts will be added to the list.
5. Click on the chart titles to highlight the ones you want to copy to your hard drive.

 Highlight multiple charts at once.  To highlight several charts in a row, hold down the Shift key on your
keyboard while you click on charts (all the charts between the ones you have clicked will automatically be
highlighted).  To highlight several charts scattered through the list, hold down your Control key while you
click on the charts you want.

 Get details about a particular chart.  Use the scroll bar at the bottom of each chart list to see various
details about each chart, including edition number, revision date, NTM information, etc.  (The information
available here is also provided in the Chart List:  refer to the Chart List help topic for further explanations
of the types of information available.) You can also get details about a chart by highlighting it and pressing
the Info button.
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 Space Required.  As you select charts to copy, the Space Required figure at the bottom of the window
shows you how much disk space you'll need for the charts you have selected.  This number will change as
you select additional charts.

6. When you have made your selections, press the Copy button in the center of the window.  The charts will now
be copied to the hard drive you have specified.

Copying the Entire Contents of a CD
In addition to charts, certain Maptech chart CDs may also contain non-chart data, such as GNIS (Geographic Names
Information System) Place Names data, Tides and Lights information, Coast Pilot Help, Symbols Help, marine
facility information, etc.  Copying this data to your hard drive will allow you access to it whenever you like, without
needing the CD.

To copy everything contained on a CD (all charts and other non-chart information):  Press the Copy All button
in the center of this window.

To copy all the charts on a CD, but no additional data:  Instead of using the Copy All button, use the Shift key
on your keyboard to highlight all charts in the list.  (Highlight the first chart in the "Charts on CD List" and, holding
down the Shift key, scroll to the last chart at the bottom of the list and highlight that chart.  All the charts in
between will automatically be highlighted.) Then press the Copy button.

Changing the Default Hard Drive
When you use this Copy Charts to Hard Drive feature, your charts are automatically copied to a particular hard
drive on your machine.  This is your default hard drive.

If you have multiple hard drives, you can tell Offshore Navigator which one to use for storing the charts.  Press the
Choose Hard Drive button to specify a different drive.

Note:  When you choose a different hard drive to use as the default drive, all the charts that are stored on your
current default drive will be moved to the new default drive.

Current Hard Drive Usage tells you how much space your charts are taking up on your current hard drive.  All
other available drives are listed, along with the amount of space available on each.

You can change the default hard drive whenever you wish, by pressing this Choose Hard Drive button.

This Copy Charts to Hard Drive feature is designed to provide a quick and easy way of transferring charts from a
CD to your machine.  Once charts have been copied to your hard drive, you can rearrange your chart storage if you
like, using the Advanced Chart Management options provided.

For details on copying Contour Charts to your hard drive, see page 51.
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Advanced Chart Management

The Advanced Chart Management feature is designed to let you manage your chart storage.

The directories shown in this list are scanned by Offshore Navigator when building the Chart List.  Every chart in
each of these directories will be included in the chart list.  (For the directories on the CD drive, you must remember
to give the Change CD/Refresh Chart List command so that Offshore Navigator will scan the CD drive's
directories.)

By manipulating the directories in this list, you can control what charts are included in the Chart List.  You can
create new directories, remove directories, and move charts from one directory to another.

• Remove:  Highlight a directory in the list and press Remove to remove it from the list.  This will not
delete the directory or its contents, but it will no longer be scanned into the Chart List.  You will need to
add it back to the chart list in order for access to those charts.

• Add:  When you have specified a new chart directory in the Chart Directory to Add window, press the Add
button to add it to the directory list.

• Copy:  Lets you copy charts to any new location.  Highlight a directory and press Copy.  A list of that
directory's charts will be displayed.  In this new window, select a chart(s), press Copy again, and choose a
target directory where you'd like the copy to be saved.

• Move:  Works just like the Copy button (described above), but moves a chart to a new location instead of
just copying it.

• Delete:  Highlight a directory and press Delete, and you will be presented with a list of that directory's
charts, from which you can select the ones you want to delete.
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• Chart Directory to Add; Browse:  Lets you specify or create a new chart directory.  Once you select the
new directory, you must press the Add button (see above) to add it to the list of chart directories.

• Rebuild Chart List:  The Rebuild button will rebuild the Chart List from the ground up, reading through all
your chart directories and any CD(s) present in your drive(s).  (CDs not present during the Rebuild will be
scanned the first time they are inserted after the Rebuild.)
The Rebuild feature is intended primarily for use as a diagnostic tool.  If you suspect that your list of
available charts is corrupt, performing a Rebuild will solve the problem or eliminate the possibility.

Chart Information

 
Click Charts, Chart Information, or right-click on the chart image and choose Chart Information, to get data
about the active chart.
 
The samples above show the different information provided for nautical charts, topographic maps, and Navigation
Photos.

 
• ID, scale, and name of the active chart.  For nautical charts, the ID is assigned by NOAA (or in some

cases, by Maptech).  For topographic maps, the ID is assigned by the USGS.  The characters in the ID
correspond to the latitude/longitude of the coverage area, the type of coverage, and the scale.  For
Navigation Photos, this ID is assigned by Maptech.  Each chart has a unique ID.

• Agency:  The agency that created the original paper chart that was scanned into electronic format.
• Navigation Photo Path:  The directory location where this Navigation Photo chart is stored.
• Edition:  The edition number of this chart.  As NOAA's nautical chart coverage of a particular region is

revised over time, a new edition is printed after each revision.  USGS topographic maps are not assigned
edition numbers, so for a topo map, this field will always be "None."  For Navigation Photos, the Edition
number corresponds to the release of the CD containing this Navigation Photo chart.  (Edition 1 indicates
that this chart image is from the first CD release for this Navigation Photo region.)
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• Date:  The date when this chart (paper original) was issued.
• Production Date:  For topo maps, this is the date that the map was initially created by the USGS.  For

Navigation Photos, this is the date that Maptech produced the Navigation Photo CD containing this image.
• NTM (Notice to Mariners) Edition:  For subscribers to Maptech's Chart Update Service.  The Chart

Update Service uses electronic chart patches to keep electronic charts as current as their paper
equivalents.  The NTM Edition tells you the paper chart edition to which this electronic chart now
corresponds.  (Since topographic maps do not receive NTM updates, in the case of topographic maps this
field will always be blank.)

• Projection:  The projection used in creating the paper original of this chart.
• Depth Units:  The unit of measurement for depth readings printed on a nautical chart.  In the case of

topographic maps, the "depth units" field refers to the units of measurement of the elevation readings
shown on the map image.  For Navigation Photos, this field is blank, since Navigation Photo charts do not
contain depth or elevation readings.

• Estimated Magnetic Variation:  The degree of magnetic variation for the chart.  The magnetic variation
figure is the number of degrees by which Magnetic North differs from True North.  This figure changes from
location to location, depending on the distance and relative bearing to the magnetic pole, and local
magnetic disturbance.

• Datum:  The datum used in creating this chart.
• Navigation Borders:  The lat/lon for the four corners of this chart's navigable area.  (Excludes notes in

margins, legends, etc.)
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Chart Notes List

As you know, paper nautical charts don't always contain perfectly rectangular chart areas.  In addition to navigable
cartographic data, other information (such as notes, legends, etc.) can occupy much of a printed chart.

For safety reasons, non-navigable areas of a chart aren't included in the on-screen display in Offshore Navigator.
To view the non-cartographic data, click Charts, List Chart Notes (or right-click on a chart and choose List Chart
Notes).  A window will appear, listing the additional pieces of information included on the paper version of this
chart.  To read any note, double-click it.

You can also hold your cursor over a See Note icon, and the corresponding note
will appear on the screen.  (To make sure See Note icons are included in the chart
display, click View, Options and check Show See Note Icons.)
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Charts at Your Location

To see a list of the chart titles available for the location you're viewing, choose Charts, Charts at This Location.
A modified Chart List window will appear, listing all the charts that share the lat/lon of the point at the center of
your screen.  To switch to one of these charts, highlight the chart and press Open (or double-click the chart title).

If you want to open one of these charts in addition to the chart you're already viewing, press Open Another.  This
will open the chart in a separate window, without closing your original chart.  If you like, you can link the two charts
together, so that the two charts will scroll together at the same time:  as you move around on one chart, the other
chart will mirror your movements.

Printing Charts

Print
 
Click File, Print to print the chart area you're viewing on the screen.  This is a one-step process, so you don't need
to make any selections or specifications.
 
The center lat/lon of the area you're viewing will be the center of your printout.   Everything you see on the screen
will be included in the print, plus some extra chart area as needed to fill the paper.  Paper orientation, print quality,
and other settings will correspond to the settings in the Print Setup window.

The printout will include the chart name, chart ID, and the coordinates of the top left and bottom right corners.
This information will be printed along the bottom of the printout.  Latitude/longitude rulers will be printed around
the border of the chart.
 
If you want to print a larger portion of a chart, use the Print Chart Packet command.
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Print Chart Packet
 

 
When you choose Print Chart Packet from the File menu, this window appears, showing an overview of the active
chart, with a grid superimposed over it.  Each rectangle in the grid represents the area covered by a sheet of paper.
(The size and/or shape of these rectangles will change if you switch your printer to a different paper size.)
 
Click to highlight the areas you'd like to print.  The area highlighted above would be printed on two sheets of paper.
If you'd like to print the entire chart, press the Select All button.  To clear all highlighting, press Clear All.  When
you have made your selections, press Print.  The chart image is printed at the same scale and resolution as the
original paper chart.

• Print:  When you have made all your selections, press the Print button to start printing.
• Print Setup:  Press Print Setup to make adjustments to your printer settings (paper size and orientation,

for example).
• Select All:  Highlights every grid in the chart overview window at right.  This selects all chart sections, so

the entire chart will be printed.
• Clear All:  Clears all the highlighting from the chart overview at right.  (If you were selecting various

sections/pages to print, and want to start over, press Clear All.)
• Calibrate:  The Calibration option is provided for use in the rare cases when a printout does not exactly

match the scale of the paper original.  For the most part, you will not need to use the Calibrate option.  If
find that there is a discrepancy between a chart printout and the paper original, you can use the Calibrate
feature to fine-tune the printout so it matches perfectly.

• Include Route Overlays:  Check this option to include routes on your printout.  This will ensure that if a
route is present on the screen in a particular chart area, it will be included when you print that portion of
the chart.

• Include Title and Index Pages:  When this option is checked, your chart printout will be accompanied by
two additional printed pages.  The Title page is printed first, and provides the chart ID and name, scale,
edition number and date, the agency that created it, datum, projection, and depth units.  The Index page
is printed next.  It provides a grid overview of the chart, with each rectangle labeled in order (A0, A1, A2,
B0, B1, B2, etc.).  Each printed chart image is then labeled with the corresponding rectangle code, so you
can use the Index page as a reference and see where each rectangular quadrant is on the chart.
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Print Setup
 

 
Choose Print Setup from the File menu (or press the Print Setup button in the Print Chart Packet window) to
adjust paper size and orientation or to select a different printer.  Press the Properties button to specify number of
copies, print quality, and adjust printer device options.  (These options vary from printer to printer, so your options
may differ.)
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Navigation Photos

A Navigation Photo linked with a nautical chart.

Maptech Coastal Navigation Photos are included in most Digital ChartKit regions.  Navigation Photos are aerial
photographs of coastal areas, georeferenced so that your overlays—vessel icon, routes, etc.—may be properly
positioned.  Navigation Photos help you discern depth changes and other details close to shore.

In the Chart List, Navigation Photos are listed under the Type heading as "Navigation Photo."  In the Navigation
Panel's chart selection bar, Navigation Photos are represented by red rectangles.  (Nautical charts are blue
rectangles, topographic maps are green.)  To open a Navigation Photo for your location, click on the red rectangle.

Note:  Navigation Photos are designed to serve as aids to navigation, and as accompaniments to nautical chart
coverage.  They should not be solely relied upon during navigation.
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Contour Charts

Maptech's Contour Charts provide a 3-D view of underwater topography.  If you have installed contour charts on
your computer, you can view underwater contour coverage alongside a nautical chart or Navigation Photo.  Choose
Charts, Link to Contour Chart, and Offshore Navigator will automatically open the contour chart that corresponds
to the location you're viewing in the active window.

Enhancing the Contour View
When contour charts have been installed, a fourth tab, appears in the Options window.  Choose View, Options and
select the Contour Charts tab to adjust display settings for your contour charts.  For example, you can adjust the
contour chart colors, assigning different colors and patterns to use for dry land, underwater terrain and the horizon.
Several optional enhancements are also available, including a depth scale and transducer cone graphic, translucent
surface layer, a depth marker that you may set  to indicate a specific depth level, and a variety of different vessel
icon shapes.  See the following page for information about all settings.

Moving Around a Contour Chart
To look at a different geographic area, you must move the nautical chart to which the contour chart is
linked.  The contour chart will follow along as you move the linked chart.

You can adjust the angle at which you're viewing the contour chart, by clicking and dragging the chart foreground.
If you hold the left mouse button down on the foreground and move the cursor up on the screen, this will "lift" the
contour chart.  If you click and drag down, it "pushes" the chart down, so you're viewing it from higher up.  You can
use the same method to spin the chart and change the angle of your viewpoint.  North, South, East and West are
labeled on the horizon, to help keep you oriented.
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Zooming In and Out
The plus and minus buttons in the Navigation Panel at the bottom of your screen can be used to
zoom in and out on the contour chart image.  Just make sure that the contour chart is active
(click the title bar at the top of the window to make the chart window active).

Contour Chart Control
When viewing contour charts, an optional control may be used for more precise chart manipulation.  The Contour
Chart Control lets you rotate the chart to any angle, tilt it up or down for a better view, and zoom smoothly in and
out.

To activate the Contour Chart Control, click View, Contour Chart Control.  (This command is only available when
the contour chart is the active window, so if you don’t see this item in the View menu, click on the title bar of your
contour chart window to highlight it and make it active.)  The Contour Chart Control will appear in the upper right
corner of your screen.  It may be dragged to another area of your screen if you prefer.

The top section of the control lets you make major viewing angle adjustments quickly and
precisely.  The chevron shape in the center represents your vessel, bow facing forward.  Click any
arrow to "look" in that direction:  for example, to look at the contours to starboard, click the arrow
pointing to the right; to look straight ahead, click the arrow that's pointing in the same direction
as the vessel icon, etc.

The "spin" ball lets you make finer adjustments.  Click any point on the spin ball to rotate or tilt
your viewing angle in that direction.  To view the chart from higher up, click the up-arrow on the
top of the spin ball.  To move your viewpoint around to the left, click the left arrow, etc.  To
continue spinning, just hold the arrow down.

Finally, the plus and minus buttons let you zoom in (+) and out (-) on the chart.  Hold either
button down for a continuous zoom.

Removing the Contour Chart Control
Click the “X” button at the top of the Control to close it.

Switching to Another Chart
You can switch charts while you're linked to contour coverage.  Simply open a different nautical chart (or Navigation
Photo) in the linked window.

As always, when you drag the linked chart, the contour chart will automatically follow along.  If you open a chart for
a different area, you may need to drag the new nautical chart slightly, to send a signal to the contour chart display
and alert it to the presence of a new chart in the linked window.
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Contour Chart Options

If you have installed contour charts this fourth tab will appear in the Options window.  Choose View, Options,
Contour Charts to adjust the following settings:

Depth Scale
A vertical line extending down from the vessel icon.  The line is notched and labeled at
regular depth intervals.

Surface Layer
A translucent, flat plane representing the water's surface.  The surface layer is shaded lightly, but you can still see
through to the contours underneath.
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Depth Marker
A horizontal, opaque plane directly underneath the
vessel icon, placed at a depth level that you specify
here.  As your vessel moves, the Depth Marker
moves with it.  The Depth Marker draws your
attention to areas within a certain depth range, and
lets you disregard areas that aren't in that range.

Shipwrecks/Obstructions
Check here to see the locations of shipwrecks and obstructions such as rocks, reefs, deadheads, piles, stumps, etc.;
marked and labeled directly on the contour charts.

Transducer Cone
Helps you visualize the amount of terrain covered in your transducer's beam angle.
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Show Outline of Contour View Area on Nautical Chart

Places a blue rectangle indicating the boundaries of the chart area displayed in the contour chart window.  (Note:
You'll only be able to see the blue outline when the nautical chart is showing more area than the contour chart.  If
the nautical chart is zoomed in closer than the contour chart, the blue outline will be outside your field of view.)

Center Screen On:
Vessel Location:  The Contour chart will "follow" the vessel icon as it moves.  The icon will always be at the center
of the screen.
Same Point as Linked Chart:  The Contour chart will match itself to the area displayed in the nautical chart
window.  (If you switch from one nautical chart to another, you may need to drag the nautical chart image slightly
in order for the contour chart window to update itself to match the new coverage area.)

Colors
Specify colors to use for different portions of the contour charts.

Trackball Arrow Controls
Refers to the Spin Ball in the Contour Chart Control. The spin ball lets you make fine adjustments to your contour
chart viewing angle.  Arrows on the surface of the spin ball represent direction of movement.  You can choose
whether the arrows should move your viewpoint, or move the landscape.  Offshore Navigator's default setting is for
the arrows to move your viewpoint, which means that if you press the forward-facing arrow, you'll be moved in
closer to the landscape.  You can change this setting as you wish.

Install Pocket Contour
If you have purchased Pocket Contour software, insert your Pocket Contour CD and press this button to installed
Pocket Contour software on your Pocket PC.  (Visit www.maptech.com for more information about Pocket Contour
software.)
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Vessel Icon on Contour Chart
Choose a shape for the contour chart's vessel icon.  In addition to Pointer and Sphere, the following shapes are
available:

Restore Default Settings
Press this button to return all options in this window to their original (Maptech) settings.

Copying Contour Charts to Hard Drive
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If you own Maptech Contour Charts (see page 46), you must copy them to your hard drive for  access. Click
Charts, Chart List (or press the Chart List toolbar button), and select the Copy Contour Charts to Hard Drive
tab. (This tab only appears when a Contour CD has been detected in your CD drive.)

The Copy Contour Charts window tells you how much room your contour charts will require (Space Required), and
how much room you have on your hard drive (Space Available). To copy the charts from your CD to your hard
drive, press Copy All>>(Contour Charts). (It is not possible to copy only selected charts; the entire CD must be
copied.)
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CHAPTER 4:  NAVIGATION

Vessel

Vessel Setup:  Data

To help Offshore Navigator provide an accurate representation of your vessel's movement, supply some details in
the Vessel Setup window.  From the Vessel/GPS menu, choose Setup, Vessel.  The window will open to the Vessel
Data tab:

Vessel
Owner's name, vessel name and vessel type (choose Power, Sail, or Other).

Vessel Size
Length:  From bow to stern.
Beam:  The maximum width.
Draft:  The depth to which the vessel sinks when afloat, measured from the waterline to the lowest immersed part
of the hull or keel.
Height:  From the waterline to the highest point (including antenna).
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Speed and Fuel
Tell Offshore Navigator your typical cruising speed and maximum speed, then press the Adjust Fuel Burn Rate
button to provide further details in the Fuel Burn Rate Table.  This data will be used to calculate trip times in Route
Planning so be sure to be as precise and accurate as possible.  (Fuel consumption information can usually be found
in the vessel manufacturer's Vessel Engine Specifications.)

 

GPS Offset
For the greatest possible position accuracy, specify where your GPS is located on board your vessel.  (These
settings are of greatest use for large vessels where the GPS is not located at the vessel's center.)

Type the distance, in feet, from the center of the vessel to the location of the GPS unit.  If your GPS is located
starboard of the centerline, type a minus sign before the number.  Also use a negative number if the GPS is located
forward of center.

Changing Settings
Any time you need to change your settings, choose Setup, Vessel from the Vessel/GPS menu, or simply right-click
on the vessel icon.

Additional settings are found under the Vessel Display tab.

Vessel Setup:  Display

From the Vessel/GPS menu, choose Setup, Vessel to provide vessel data and adjust vessel display (shown below).
Settings under the Vessel Display tab affect the vessel icon, letting you control how your vessel location is
displayed.  See below for explanations of each setting.  When you have made your selections, press OK.
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Vessel Icon

Shape:  Choose Vessel, Airplane. or Crosshairs.
Color:  Red, Green, Blue, Cyan (light blue), Yellow, Magenta, Black, or Transparent.
Size:

Length:  From bow to stern.
Beam:  The maximum width.
Draft:  The depth to which the vessel sinks when afloat, measured from the waterline to the lowest immersed
part of the hull or keel.
Height:  From the waterline to the highest point (including antenna).

Display Options
Show vessel icon:  Check whether or not you want the vessel icon to be shown on the screen.
Show course line extension:  This will display a line pointing straight out from the vessel's bow in the direction
the vessel is headed.

Range Marks
Range marks radiate out from the vessel icon, to help you gauge distance (range).  Check Show Range Marks to
include range marks on the screen.
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Circles:  Four circles will surround the vessel.
Ticks:  Ten tick marks, of graduated size, will extend forward from the vessel's bow.
Measured by Distance:  Specify an interval at which the marks should be set.  (According to the settings in
this sample graphic, the range marks would be 0.5 nautical miles apart.)
Measured by Time:  Specify a time interval in minutes.  Offshore Navigator will set the range marks at
intervals that show how far the vessel will travel in that time interval.  This lets you see at a glance how many
minutes away you are from a given point.

Icon Orientation
"At speeds of less than X miles per hour, use Relative Vessel Heading instead of COG (Course Over Ground) for
vessel orientation."

This feature is intended primarily for use by very large craft when maneuvering in tight or congested areas, like
harbors, loading docks, etc.  This feature is only available for use on vessels equipped with a compass that
transmits NMEA data.

Ordinarily, your vessel's orientation is aligned to your COG (Course Over Ground):  your path of travel.  This means
that the vessel icon points directly in line with your heading.  However, moving at slow speeds causes a vessel to
become more susceptible to current, wind, etc.  In such cases, the vessel may experience a certain degree of
rotation or "sideslip." In such a case, the vessel might be moving along a 45 degree course, but the bow might be
angled at 43 degrees.

For most craft, such a deviation would not pose a problem in navigation.  Careful attention when maneuvering in
congested areas is usually a sufficient precaution to avoid traffic difficulties or collisions.  But for a very large vessel,
such as a freighter or a barge, a difference in orientation angle is magnified.  In addition, large craft require more
time to turn or slow down.  Using the Relative Vessel Heading to position the vessel icon on the chart helps Offshore
Navigator provide the most accurate vessel position and orientation.

Check the Orientation checkbox, and specify the speed below which you would like to use Relative Vessel Heading
to orient the vessel icon.

Vessel Position Source

Offshore Navigator can move the vessel icon across the chart images in a
representation of actual vessel movement across the water.  There are two sources
from which Offshore Navigator can get vessel location data, so that it "knows" where
to place the vessel icon.

 A connected GPS.  If you are on the water and cruising, turn on the GPS connection and your position will
be marked on the charts and updated every three seconds.

 The vessel movement Simulator.  This lets you simulate vessel movement to help you plan a cruise in
advance—even before you get on the water.

Since there are two possible data sources, there are two Vessel Positioning options.  From the Vessel/GPS menu,
choose Position from GPS or Position from Simulator to specify where position data should come from.  When
neither is selected, the vessel icon will remain stationary unless you manually move it.  (You can click-and-drag to
move the vessel icon, or you can right-click anywhere on a chart and choose Put Vessel Here.)

Once a Position source is selected, the vessel icon will begin to move at the speed and course indicated by the GPS
or the Simulator.  To stop the movement of the vessel icon, uncheck the current Position option on the Vessel/GPS
menu.
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GPS

GPS Setup
 

 
Before Offshore Navigator can establish communication with your GPS unit, you need to supply some information so
the GPS can be properly configured.

 

Configure Your GPS Settings Easily with the GPS Setup Wizard
The fastest and easiest way to get Offshore Navigator properly configured for your GPS is to use the GPS Setup
Wizard.  The Wizard will automatically detect your GPS, find out its make and model, and determine what COM port
it is connected to on your computer.  The Wizard will then make all necessary settings so Offshore Navigator can
communicate with your GPS unit, and vice versa.  If any connection problems are detected, the Wizard will likely
tell you exactly how to fix them.  All you have to do is click Vessel/GPS, Setup, GPS Setup Wizard and follow
the simple instructions on the screen.

When the Wizard is finished, Offshore Navigator will be ready to communicate with your GPS unit.

GPS Status
As explained on page 55, when you click Vessel/GPS, Position from GPS Offshore Navigator will place the vessel
icon at the coordinates received from your GPS unit.  As your vessel moves, so will the vessel icon.  This is called
GPS Navigation.

During GPS Navigation, your GPS signal status is represented by an icon and note in the lower right corner of your
screen.  These brightly colored square icons show you your GPS status at a glance; for more details, click on the
icon and a message will provide more information.
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When your GPS is sending valid position data, a green check mark indicates
that all is well.

If your GPS temporarily loses its satellite fix, a yellow exclamation point
notifies you that there isn't enough data being received from your GPS in order

to accurately plot your location. You should make sure that your GPS antenna is properly connected to the GPS unit,
and that the antenna has a clear view of the sky.

A red "X" indicates that your GPS connection has been cut off.  Either the GPS
was turned off, or the cable became disconnected.  Plug it back in, and wait for

your GPS to reestablish your location.  (To avoid seeing this "X," uncheck Vessel/GPS, Position from GPS when
you no longer require a GPS signal.)

When you're not using your GPS for navigation, this icon and message serve
as a reminder that the vessel icon DOES NOT necessarily indicate your GPS

position. Since the icon isn't being positioned according to the GPS data, you can move the icon by clicking-and-
dragging it with the mouse cursor.   Pressing the icon (black dot) will open the GPS Setup window (see page 57).

Dead Reckoning

 

If a problem develops and your GPS is no longer able to send out an accurate position fix, Offshore Navigator can
continue to simulate your vessel's progress along a route, using the values you set in Dead Reckoning.
 
To enable Dead Reckoning in the event of GPS failure, choose Setup, GPS from the Vessel/GPS menu, and check
the Allow Dead Reckoning checkbox.  Set a time interval for Offshore Navigator to attempt reconnection to your
GPS.  (The most often Offshore Navigator can retry is once a minute.)
 
Type in your estimated speed and heading, along with the current drift and set, and Offshore Navigator will move
your vessel icon over the charts to correspond to your settings.
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Autopilot (FULL VERSION ONLY)

Setup   

An Autopilot is an external unit that controls the steering of the vessel.  Offshore Navigator supports Autopilot use,
so if your vessel is equipped with a GPS unit and an Autopilot, you can interface these two devices via a computer
running Offshore Navigator.  In this way, you can select a route in Offshore Navigator and have your Autopilot
follow it.
 
To configure communication settings for using your Autopilot with Offshore Navigator, choose Setup, Autopilot
from the Vessel/GPS menu.
 
Offshore Navigator gets current position data from the GPS and sends it, along with data for the selected route, to
the Autopilot.  This communication takes place using the NMEA (National Marine Electronics Association) 0183
Standard for Interfacing Marine Devices.
 
NMEA 0183 defines electrical signal requirements and specific sentence formats, or "NMEA sentences." Each
sentence represents a particular type of data- one sentence might provide the time and date, another sentence
might contain the bearing from waypoint to waypoint, etc.  Some of these strings are generated by Offshore
Navigator, and some are taken directly from the GPS unit and passed through Offshore Navigator to the Autopilot.
 
Offshore Navigator can generate NMEA sentences and send them to the Autopilot.  Select the sentences you want
from the options under Sentences to Generate.  Three are pre-selected for you:
APB:  Heading/Track Controller (Autopilot) Sentence "B"
HSC:  Heading Steering
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XTE:  Cross-Track Error, Measured
 
You can change these selections and/or choose other sentences; see the following page for a list of character IDs
and NMEA Sentences.
 
When you have configured your settings, establish communication between Offshore Navigator and the Autopilot by
checking GPS On and Autopilot On.  You are now ready to use your Autopilot to follow a route (see page 112).

Note to Garmin GPS Users:  In order to work with your Autopilot, your GPS Interface option must be set for
NMEA.  (The "Garmin" or "Garmin/Garmin" interface option, which is necessary for the transfer of stored coordinate
data to and from your computer, will prevent Autopilot communication.  Remember to change the interface in your
GPS unit when you wish to operate your Autopilot.  Consult your GPS user's manual for instructions.)
 

Passthru Data

 

NMEA 0183 defines electrical signal requirements and specific sentence formats, or "NMEA sentences." Each
sentence represents a particular type of data- one sentence might provide the time and date, another sentence
might contain the bearing from waypoint to waypoint, etc.
 
The settings under the Passthru tab apply to your GPS unit.  The Passthru window lets you select the NMEA
sentences that you would like the GPS to pass directly through Offshore Navigator, without modification, to the
Autopilot.  To specify which sentences you want to pass through, choose Setup,  GPS or Setup, Autopilot from
the Vessel/GPS menu, and click on the Passthru tab.

Three sentences are pre-selected for you:
GLL:  Geographic Position – Latitude/Longitude
RMC:  Recommended Minimum Specific GNSS Data
VTG:  Course Over Ground and Ground Speed
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Table of Passthru Character IDs/Sentence Formatters

The following list was taken from the NMEA 0183 Standard for Interfacing Marine Electronic Devices.
 

CHARACTER
ID

DEFINITION

AAM Waypoint Arrival Alarm

ACK Acknowledge Alarm

ALM GPS Almanac Data

ALR Set Alarm State

APB Heading/Track Controller (Autopilot Sentence "B")

BEC Bearing & Distance to Waypoint – Dead Reckoning

BOD Bearing – Origin to Destination

BWC Bearing & Distance to Waypoint

BWR Bearing & Distance to Waypoint – Rhumb Line

BWW Bearing – Waypoint to Waypoint

DBT Depth Below Transducer

DCN Decca Position

DPT Depth

DSC Digital Selective Calling Information

DSE Expanded Digital Selective Calling

DSI DSC Transponder Initialize

DSR DSC Transponder Response

DTM Datum Reference

FSI Frequency Set Information

GBS GNSS Satellite Fault Detection

GGA Global Positioning System Fix Data

GLC Geographic Position – Loran-C

GLL Geographic Position- Latitude/Longitude

GNS GNSS Fix Data

GRS GNSS DOP and Active Satellites

GSA GNSS Pseudo Range Error Statistics

GST GNSS Satellites in View

HDG Heading, Deviation & Variation

HDT Heading, True

HMR Heading Monitor Receive

HMS Heading Monitor Set

HSC Heading (Steering)

HTC Heading/Track Control Command

HTD Heading/Track Control Data

LCD Loran-C Signal Data

MLA GLONASS Almanac Data

MSK MSK Receiver Interface

MSS MSK Receiver Signal

MTW Water Temperature

MWD Wind Direction & Speed

MWV Wind Speed & Angle

OSD Own Ship Data

RMA Recommended Minimum Specific Loran-C Data
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RMB Recommended Minimum Navigation Information

RMC Recommended Minimum Specific GNSS Data

ROT Rate of Turn

RPM Revolutions

RSA Rudder Sensor Angle

RSD Radar System Data

RTE Routes RTE – Routes

SFI Scanning Frequency Information

STN Multiple Data ID

TLB Target Label

TLL Target Latitude/Longitude

TTM Tracked Target Message

TXT Text Transmission

VBW Dual Ground/Water Speed

VDR Set & Drift

VHW Water Speed & Heading

VLW Distance Traveled through Water

VPW Speed, Measured Parallel to Wind

VTG Course Over Ground & Ground Speed

WCV Waypoint Closure Velocity

WNC Distance – Waypoint to Waypoint

WPL Waypoint Location

XDR Transducer Measurements

XTE Cross-Track Error, Measured

XTR Cross-Track Error, Dead Reckoning

ZDA Time & Date

  

Sentence Formatters Not Recommended for New Designs
(These sentences are sometimes used by older Autopilots.)
 

CHARACTER
ID

DEFINITION

APA Autopilot Sentence "A"

BER Bearing & Distance to Waypoint, Dead Reckoning,
Rhumb Line

BPI Bearing & Distance to Point of Interest

DBK Depth Below Keel

DBS Depth Below Surface

DRU Dual Doppler Auxiliary Data

Gda Dead Reckoning Positions

Gla Loran-C Positions

Goa OMEGA Positions

Gxa TRANSIT Positions

GTD Geographic Position, Loran-C TDs

GXA TRANSIT Position

HCC Compass Heading

HCD Heading & Deviation

HDM Heading, Magnetic

HVD Magnetic Variation, Automatic

HVM Magnetic Variation, Manually Set
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IMA Vessel Identification

MDA Meteorological Composite

MHU Humidity

MMB Barometer

MTA Air Temperature

MWH Wave Height

MWS Wind & Sea State

OLN Omega Lane Numbers

OLW Omega Lane Width

OMP OMEGA

ONZ Omega Zone Number

Rnn Routes

SBK Loran-C Blink Status

SCY Loran-C Cycle Lock Status

SCD Loran-C ECDs

SDB Loran-C Signal Strength

SGD Position Accuracy Estimate

SGR Loran-C Chain Identifier

SIU Loran-C Stations in Use

SLC Loran-C Status

SNC Navigation Calculation Basis

SNU Loran-C SNR Status

SPS Loran-C Predicted Signal Strength

SSF Position Correct Offset

STC Time Constant

STR Tracking Reference

SYS Hybrid System Configuration

TEC TRANSIT Satellite Error Code & Doppler Count

TEP TRANSIT Satellite Predicted Elevation

TGA TRANSIT Satellite Antenna & Geoidal Heights

TIF TRANSIT Satellite Initial Flag

TRF TRANSIT Fix Data

TRP TRANSIT Satellite Predicted Direction of Rise

TRS TRANSIT Satellite Operating

VCD Current at Selected Depth

VPE Speed, Dead Reckoned Parallel to True Wind

VTA Actual Track

VTI Intended Track

VWE Wind Track Efficiency

VWR Relative (Apparent) Wind Speed & Angle

VWT True Wind Speed & Angle

WDC Distance to Waypoint

WDR Waypoint Distance, Rhumb Line

WFM Route-Following Mode

WNR Waypoint-to-Waypoint Distance, Rhumb Line

YWP Water Propagation Speed

YWS Water Profile

Zaa Time, Elapsed/Estimated

ZCD Timer

ZEV Event Timer

ZLZ Time of Day
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ZZU Time, UTC

Advanced Autopilot Setup

 

The Advanced Autopilot Setup window lets you modify the settings that govern Offshore Navigator's communication
with your Autopilot.

For information on choosing settings, refer to your Autopilot’s User Manual.
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Data Windows

 

Data windows are designed for quick reference during navigation.  They can also be activated in simulation mode.
There are several kinds of data that you can select for display.  To configure your data windows, go to the
Vessel/GPS menu and choose Setup, Data Windows.

Data Windows Setup
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The left-hand window lists the values that you can choose to include on your screen during navigation.  Pick a value
that you want, and click to select it.  Then, press the > button to transfer the value to the right-hand window
(Viewable Values).  The values you place on the right-hand side will be included in your data windows.
 
Use the >> and << buttons to transfer all the values at once, and use the > and < buttons to move one value at a
time.  You can include as many as you want, but bear in mind that because your screen space is limited, it is
usually easier to use just a few values at a time.
 
Press Font Settings to specify the fonts to use for the data readings and their headings, and also to adjust the
colors used in the data windows.  (Note:  Color changes will only take effect when your Chart Color Scheme setting
is Normal.  Choose View, Options, Chart Display to adjust your chart color scheme.)

Font Settings also lets you choose Full Titles if you prefer that each data window be identified by a full title instead
of an abbreviation.

Turning Data Windows On and Off
To bring data windows into view, check the Data Windows option on the View menu.   Uncheck it to turn data
windows off.
 

Moving Data Windows
You can move the data window display to another area of your screen- just click and drag to reposition the window.
In addition, you can remove individual values from the data window display- right-click on the value and choose
Hide.

Units of Measurement, Lat/Lon Format, True/Magnetic North...
To adjust how your data is presented, choose View, Options, Chart Display.  These settings affect all data
displays in Offshore Navigator, including data windows.

Note on Cross-Track Error
When you are off course, the Cross-Track Error (XTE) data window tells you whether you are left or right of your
course line, and how far you are from it.  In the example XTE window below, “L 0.14 km” indicates that the vessel
is 0.14 kilometers left of the course line.  IMPORTANT:  “L” and “R” indicate your vessel’s position relative to the
course line.  They are NOT steering commands.
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Contour Look-Ahead (When Contour Charts are Present)
If you have installed contour charts on your computer, a special data window is available.  This Contour Look-Ahead
data window provides a cross-section view of depth changes in the upcoming 3/4 mile of your course.  (See page
46 for more about contour charts.)

Data Value Abbreviations

Abbreviations conserve space and enable quick identification.  Below is a list of abbreviations and their meanings.

ABBREVIATION DATA VALUE

D NWpt Distance to Next Waypoint
D Dest Distance to Destination
T NWpt Time to Next Waypoint
T Dest Time to Destination
D/T Date/Time
RB NWpt Range/Bearing to Next Waypoint
RB LWpt Range/Bearing to Last Waypoint
STW Speed through Water
RB Cur Range/Bearing to Cursor
RB Ves Range/Bearing to Vessel
HDG Heading
ETA NWpt ETA at Next Waypoint
ETA Dest ETA at Destination
XTE Cross-Track Error (see below)
COG Course Over Ground
SOG Speed Over Ground
Ves LL Vessel Latitude/Longitude
Cur LL Cursor Latitude/Longitude
NWpt Name and Number of Next Waypoint
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Steer NWpt Course to Steer to Next Waypoint
Set/D Current Set and Drift
Contour Contour Look-Ahead

Tracks (FULL VERSION ONLY)

Recording Tracks
 

 
Offshore Navigator includes a tracking feature, which lets you record the vessel's course.  The tracking feature may
be used when you are actually in motion on the water, or when you are simulating vessel movement.
 
To record a track, choose Tracks, Record from the Vessel/GPS menu.  The Record Track Log window, shown
above, will appear.  You can choose options for how to record the track, assign the track a name, and decide how it
should look on the chart.  Press OK, and start the vessel icon moving (choose a Navigation Mode from the
Vessel/GPS menu).
 

Name/Note:
Assign the track a name, and a brief note if you wish.  (Neither will appear on the chart, but you can read
name/notes in Track Log Properties.)
 

Track Recording Options
• New:  Makes an entirely new track.
• Open/Append:  This option lets you add on to an existent track.  Select the track's name from the drop-

down Name list (at left).
• Open/Overwrite:  You can effectively "redo" a track.  Choose a track from the drop-down Name list at

left.  The track you choose will be deleted from Offshore Navigator and your new track recording will take
its place.
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Symbol/Color
Choose a symbol to mark your track points.  You can preview each symbol in the preview pane provided.  Also, pick
a color to use for your track line and points.
 

Record Track By:
• Time:  Select a time interval (how often Offshore Navigator will mark your vessel position with a track

point symbol).
• Distance:  Instead of setting a track point at regular time intervals, this sets track points when the vessel

has moved a certain distance.  Distance is measured in nautical miles.
• Error:  Let Offshore Navigator decide how often to set track points on the chart.  Instead of creating track

points at regular intervals of time or distance, Offshore Navigator will simply set a track point whenever
your course's direction changes more than the amount you specify.  (Using this method, Offshore
Navigator creates only as many track points as are necessary to mark your course.  In other words, if you
travel in a straight line for some time, Offshore Navigator will only set track points at the beginning and
end of the straight segment.)

A track being recorded.

 
You can temporarily pause the recording by choosing Tracks, Pause from the Vessel/GPS menu.  To stop recording
and finish the track, choose Tracks, Stop.  (You can continue to add to the track at a later time if you wish, using
the Open/Append option in the Record Tracks window, pictured above.)
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Track List
 

 
Offshore Navigator lets you record tracks during vessel movement.  (You can also transfer track logs into Offshore
Navigator from a GPS unit.) To see a list of your track logs, choose Tracks from the Locate menu, or choose
Tracks, Tracks from the Vessel/GPS menu.
 
From the Track List, you can pick a track to view on the screen, edit a track's properties, convert a track into a
route, delete tracks, etc.  Click on the buttons in the image above for details.
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Convert/Filter Track Log
 

Offshore Navigator includes a Track-to-Route/Filter New Track conversion feature.
 

Create a Route from a Track Log
If you have a track log whose course you'd like to follow in your vessel, convert it to a route so Offshore Navigator
can follow it.
 

Filter to New Track Log, with Fewer Track Points
This lets you filter an existent track log, so the new version contains fewer track points.  This is often handy when
working with track logs that have been transferred from a GPS unit, since such track logs often contain a large
number of points.
 
The Convert Track window provides data on each point, so you can pick the points to include in the new track/route.
 

• Name:  The name of this track log.
• Note:  A brief note that you typed that you assigned the track (or in this example, the Note tells the

source of the track log- transferred from GPS).
• Track Points in Log:  The total number of track points in this track log.
• Track Points Checked:  The number of track points that are presently selected for inclusion in the new

route/track.  This number will change as you experiment with different selection methods, below.
• Check to Include Track Points From Log:  Data for each track point in this track log.  The checkboxes

at left indicate whether the point is to be included in the new track/route.
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Select Track Points
Several methods are available for selecting which track points to include in the new track/route.  You can check
individual points by hand in the Track Point List above, or use the options here and have Offshore Navigator
automatically filter the points for you.
 
Pick a selection method and press the Refresh button to see how that method affects your track point list.  The
track points that would be removed will be unchecked.  The Track Points Checked at top right gives you the total
to be included in the new track/route.
 

• All:  Keeps all the track points (use this if you want to create a route with waypoints that correspond
exactly to these track points).

• None:  Use this to clear your selections and start over.
• Time:  Select a time interval.  Example:  If you choose 00:02:00, Offshore Navigator will select the track

points that would be closest to the vessel location every 2 minutes while traveling this course.
• Distance:  Instead of selecting track points at regular time intervals, this selects the track points that

would be nearest to the vessel each time the vessel moves a certain distance.  Distance is measured in
nautical miles.

• Error:  Let Offshore Navigator decide which points to include.  Instead of selecting track points at regular
intervals of time or distance, Offshore Navigator will select only the track points that are nearest to a
change in course direction.  In other words, if the track continues in a straight line for a great distance,
Offshore Navigator will only select the track points at the beginning and end of the straight segment, and
exclude the points between them.

Specify the amount of error that you will tolerate.  The smaller the distance, the more closely the new track/route
will follow the original track's course.  However, insisting on a very small error amount can make it hard to reduce
the number of track points significantly.  Experiment with various error amounts and press the Refresh button to
see how different error amounts affect the track point total for the new track/route.
 
Refresh:  The Refresh button lets you "test" your settings before you finalize anything.  Make a selection, and
whenever you want to see how your selection would affect the new track/route, press Refresh to see which points
are checked in the list above.
 

When you have made your track point selections:
To create a route, press Convert to New Route.
To create a new track, press Filter to New Track Log.
You will be prompted to type a name for each new track/route that you create.  (Your original track remains in
Offshore Navigator.) Press Done to exit.
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Track Log Properties
 

 
The Track Log Properties window lets you:

• Adjust the track's appearance (track point symbol and color)
• Get the track's total distance and number of track points
• Add a note about the track (or read existing notes)
• See how the track was recorded ("record By" settings)

To view Properties for a track:
• Right-click on one of the track's waypoints, and choose Track Log Properties; or
• Choose Tracks, Tracks from the Vessel/GPS menu to view the Track List, then highlight the track name

and press the Properties button, and select the Track Log Properties tab.

Other tabs in the Track Properties window:
Select the Track Point List tab to get data about each track point in the track log.  Highlight a track point, then
select the Track Point Properties tab to add a note about that particular point.
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Track Point List
 

 
The Track Point List window gives the name, lat/lon and other data for each track point in a track log.
 

• Right-click on one of the track's waypoints, and choose Track Point List; or
• From the Track List, highlight the track name and press the Properties button, and select the Track Point

List tab.
 

Recalculate SOG/COG
If you would like to apply different numbers for Speed Over Ground (SOG) or Course Over Ground (COG), you can
change the numbers and then press Recalculate SOG/COG to see the effects of your changes.
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Track Point Properties
 

 
If you like, you can assign a name to a track point, and type a short note about it.
 

• Right-click on one of the track's waypoints, and choose Track Point Properties; or
• From the Track List, highlight the track name and press the Properties button, and select the Track Point

Properties tab.
 
(Select the desired track point from the Track Points List tab in the Properties window.)

Alarms (FULL VERSION ONLY)
 

What is an Alarm?

An alarm is an area you define on a chart, so that Offshore Navigator can warn you when your vessel enters or
leaves that area.
 
For example, you might set an alarm around an area of shallow rocks, and ask Offshore Navigator to warn you if
you enter that alarm zone.  Or, you could delineate an area where you'd like to fish, and Offshore Navigator can
warn you if you drift beyond the boundary you set.  Alarms appear on the charts as outlines filled in by red cross-
hatching (or in the case of line alarms, simply a collection of line segments).
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A line alarm, which will be triggered if the vessel crosses it.

  

Entry vs.  Exit
When you create an alarm that is an enclosure, you must specify whether it is an Entry alarm or an Exit alarm.
Entry alarms are triggered when the vessel enters the alarm area; exit alarms are triggered if the vessel exits the
alarm area.
 
An Entry alarm, delineating a shallow area.
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Use an Exit alarm to mark a good fishing spot.

Creating Alarms

Line/Shape Alarms
Select the Line/Shape Alarm button on the toolbar, and click on the chart to create an alarm line or
enclosure.  Each place you click is joined by a line.  When you have finished adding line segments, right-
click and choose Save.

 

Creating a Line Alarm

 
If you create an enclosure, it will be filled in with red cross-hatching.
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Creating a Shape Alarm

 

Ellipse Alarms
From the Tools menu, choose Alarms, Create Ellipse Alarm to create a round or elliptical alarm area.  Click on
the chart, and hold the left mouse button down.  As you move the cursor away from the point where you clicked,
the alarm circle will grow.  Release the mouse button when the circle is the size you want.
 

Creating an Ellipse Alarm

 

The Anchor Alarm
The Anchor Alarm is an ellipse alarm, surrounding your vessel when anchor is set.  It is by nature an Exit
alarm.  You tell Offshore Navigator the amount and direction of drift that is acceptable at anchor, and if
the vessel strays beyond this range, the anchor alarm will be triggered.

Anchor alarm.
To configure the Anchor Alarm, press the Anchor Alarm toolbar button, or choose
Alarms, Create  Anchor Alarm from the Tools menu.  This will place a special ellipse
alarm directly over your vessel icon.  You can then click-and-drag to stretch the alarm
zone as needed.
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Another way to configure the anchor alarm:  from the Tools menu, choose Alarms, Alarm List.  This will bring up
the Alarm Setup window, which contains a space for you to type the Anchor Alarm Diameter.
 
 

Alarms Setup
 
The options in the Alarm Setup window let you choose settings to apply automatically to any new alarms you
create.
 

Notification Type
The method by which Offshore Navigator notifies you when this alarm is triggered.  Choose one or both.
Visual:  A window will appear on the screen, listing the alarms that have been triggered, with this alarm listed first.
Auditory:  A warning beep will sound.

Anchor Alarm Diameter
The range to which the vessel can drift when anchor is set.  If the vessel moves beyond the range you assign, the
anchor alarm will be triggered.

Alarm Type
Entry:  The alarm will be triggered when the vessel enters the alarm zone.
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Exit:  The alarm will be triggered when the vessel exits.
(For the Anchor Alarm, these options are grayed out because the Anchor Alarm is always an Exit alarm.)

Activate
For an alarm to perform its job, it must be activated.  For safety reasons, all alarms you create are automatically
activated.  If you want to temporarily disable an alarm, you can uncheck this Activate option.

When an alarm is deactivated, the cross-hatching is shown in green instead of red, and the alarm points change
from red to gray.  This serves as a visual reminder that the alarm has been deactivated.

Lock
To ensure that this alarm is not accidentally moved on the chart, check the Lock option.  You won't be able to click-
and-drag the alarm until you uncheck Lock.

Prompt for Properties upon Creation
When this option is checked, every time you create and save a new alarm the Alarm Properties window will
automatically appear on the screen, so you can adjust the settings for the new alarm.  (This is a timesaver if you
are planning to create several different types of alarms in a row; it saves you the time of right-clicking and choosing
Properties for each new alarm.)

 

Alarm Properties 

To assign a name to the alarm, choose a notification method, decide whether the alarm should be an Entry alarm or
an Exit alarm, etc., right-click on the alarm and choose Properties.  The Properties window will open to the Display
tab.

The Alarm Properties window lets you do several things with an alarm:  assign it a name, record notes about it, set
it to be Entry or Exit, type a message to be displayed when the alarm is triggered, temporarily disable it, etc.

 
For access to these settings, tight-click on an alarm point and choose Properties.
 
There are four other possible Properties tabs:
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• Type:  Lets you choose Notification Type (visual or auditory), and specify whether this is an Entry or Exit
alarm.  You may also type a short Message to be displayed in the Triggered Alarms window when this
alarm is triggered.

• Points (for Line/Shape alarms):  Lets you edit each point's coordinates, or insert a new point by
assigning coordinates.  Provides total length of alarm line.

• Size (for Ellipse alarms):  Adjust the lat/lon of the alarm's center point, and its total height and width.
• Notes:  A space for you to record or view your notes about this alarm.

Adjusting Alarms’ Size and Shape
 

Line/Shape Alarms
To change the size or shape of a polygon/line alarm, grab one of the bell symbols at the corners, and drag that
alarm point to a new location.

 

Ellipse Alarms (including Anchor Alarm)
You can stretch or shrink an ellipse alarm.  Hold the cursor over the alarm's center (or its edge) and double-click.  A
frame will appear, with small green “handles.” You can grab the alarm edge at any of these handles, and drag in
any direction to stretch or shrink the alarm zone.  Release the mouse button to complete your adjustment.

You can also adjust alarms’ size using the Properties window (right-click on an alarm point and choose Properties).

  

Moving Alarms
 

Line/Shape Alarms
To move a polygon/line alarm, grab an edge (or line segment) and drag the entire alarm to a new location.
 
You can also assign alarms to new locations using the Properties window (right-click on an alarm point and choose
Properties).

Ellipse Alarms
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Hold the cursor over center (or the edge) of the alarm area.  The cursor symbol will change into a cross shape, and
you can drag the alarm outline to a new location.  When you release the mouse button, the entire alarm will move
into the location you have selected.
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Triggered Alarms

 
Offshore Navigator will warn you if you trigger an alarm (by entering or leaving an alarm zone).
 
To view a list of alarms you have triggered, choose Triggered Alarms from the View menu, or click the bell symbol
in the Status Bar.

When an alarm is triggered, you acknowledge this by pressing the Confirm button.  This is a safety feature
designed to tell Offshore Navigator that you have received the alarm notification.

Unconfirmed alarms are marked here with a red exclamation point.  Once you confirm an alarm, a green checkmark
appears instead.

The Quiet button lets you turn off the alarm sound (for auditory alarms), but does not confirm the alarm.

(The bell symbol in the Status Bar is red if the Triggered Alarms list contains unconfirmed alarms.  When all
alarms are confirmed, the bell symbol turns green.  If the Triggered Alarms list is empty, the bell is gray.)

Locate will display the chart area that contains the highlighted alarm.  Confirm All will confirm all alarms at once,
and Print List will print the Triggered Alarms list.



84

Using the Simulator

The Simulator helps you visualize your vessel's movement
under different conditions, without having to actually be on
the water.  Using the Simulator, you can specify current
set (direction) and drift (speed) and see how those
conditions would affect your vessel's progress at various
speeds.
To specify Simulator settings, choose Setup, Simulator
from the Vessel/GPS menu.

Time Compression
The Time Compression lever controls the rate at which the
vessel's movement is simulated.  When the slider is all the
way to the left, the simulation is portrayed in real time
(representing actual vessel progress).  Slide the lever to
the right to speed it up.

This is like watching a film in fast-forward mode:  the
events remain the same, but they are displayed at a
slower or faster pace.  This Time Compression control lets
you adjust the length of time that Offshore Navigator takes
to simulate a particular route or course of travel, without
requiring that you assign a higher vessel speed.

Note:  You may find that you don't need to use a very
high Time Compression factor.  Try a low setting, like 5, to
start.  (To fine-tune number selection, click on the lever
and then press the right arrow on your keyboard to raise
the Time Compression factor by one digit at a time.)

Active Route
This section of the Simulator Setup window only applies if you're following a route.  (When you're not following a
route, this entire section is grayed out.)

Following active route:  This is automatically checked if you're following a route.  If you want to pause the route,
just uncheck this box.  Check it again to resume the route.

Only use route plan headings:  Lets you see what would happen if the vessel's course were NOT corrected for
the effect of a current.

Offshore Navigator will rely on the route plan, using the bearing to the next waypoint as the vessel heading.  For
example, if Waypoint 2 is at a bearing of 18 degrees from Waypoint 1, Offshore Navigator will assign a vessel
heading of 18 degrees, which you may not adjust.  The heading will only be changed as each waypoint is achieved.
(In this case, a waypoint is considered "achieved" once the vessel icon has traveled a distance equivalent to that
route leg—regardless of how close the vessel icon actually is to the waypoint.)

Also apply vessel data:  Lets you make course adjustments as necessary to compensate for the effect of the
current.  This is a "hands-on" way to determine how much of a correction is needed under different conditions
(which you set in this window).

To adjust your course, type different Heading and Speed values in the space provided in the Simulator Setup
window.  This lets you react to extraneous conditions—namely, the current set and drift that you specify here in
Simulator Setup—and make adjustments accordingly.  In this way, you can do a "dry run" of a route and find out
exactly what corrections you would need to make to stay on course under different conditions.
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Vessel Speed and Heading
You must also type vessel speed and heading.  (Vessel speed may be already filled in, using whatever figures you
entered in the Vessel Setup window, but you can change speed and heading as you like.)
Note:  While you're following a route, this section is grayed out UNLESS you have chosen to Also apply vessel data
(see above).  Once the route is ended, the Simulator will once again use this Vessel data.

Current Set and Drift
You may type a current Drift (speed) and Set (heading).  These conditions will be applied to the vessel icon.
Unless you leave both settings at zero, the vessel icon will be deviated from the plotted course.  If you want to see
how different current conditions would affect your course if you made no heading corrections, check Only use route
plan headings.  If you want to be able to make course corrections as necessary, check Also apply vessel data.

Starting Simulation
When you have made all settings, press OK and the Simulation will automatically begin.  The vessel icon will move
across the chart in the direction, and at the speed, that you specified.  You can start and stop Simulation by
checking/unchecking Position from Simulator at the top of the Vessel/GPS menu.  (To bring the vessel icon into
view, press the Locate Vessel toolbar button.  To keep it in view, check the Follow Vessel checkbox at the
bottom of the chart window.)
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The Ship's Log (FULL VERSION ONLY)

Offshore Navigator's electronic Ship's Log lets you keep an official record of your vessel position, course, speed and
progress, and print this information for use as a paper reference.  The data you collect may also be exported to a
text file for electronic transfer or use in other programs.

To open the logbook, click Vessel/GPS, Ship's Log.  The top portion of the window is a list of Logbook entries for
a given date.  Highlight an entry to read it in the Entry Details section below.  The most recent entry is shown at the
bottom of the list and is automatically highlighted and displayed.

Making a New Entry
To make a log entry, press New Log Entry.  This will open a new window, noting your position, speed, and course
at the moment when you pressed the New Log Entry button.  If you like, you can add comments under
Notes/Weather.  When finished, press OK and the entry will be saved in the log.

Note:  You can also bring up the Log Entry anytime simply by pressing the letter "L" on your keyboard.
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Paging through Previous Entries
To look back in the logbook for previous dates, use the Page controls at the top of the window.  Each Page
represents one 24-hour period, but Pages are only created for days that have logbook activity.  If you make no
entries on a particular date, no Page will be created.  Pressing either Page button will take you to the closest day for
which log entries were made.  In other words, regardless of how long it has been since your last cruise, you'll only
need to press < Page once in order to bring that date into view.  Likewise, the < 7 Pages and > 7 Pages buttons
will skip through calendar days as necessary in order to move through ten dates with logbook entries.  This
prevents you from having to skim through blank days when you're looking for entries.

Scheduling Timed Log Entries

Offshore Navigator can automatically log your vessel position, course and speed at regular intervals.  To activate
this automatic timing feature, press the Options button found in the logbook window, and select a time interval.
Entries can be made hourly (on the hour), or every 30 minutes (on the hour, and at half-past).
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Important:  Keep in mind that timed entries are made not only while you're underway, but whenever Offshore
Navigator is running.  Offshore Navigator will continue to record log entries regardless of vessel activity until you
turn this option off (by clicking the Options button and unchecking the checkbox).

In addition to your automatically timed entries, you can still make log entries manually whenever you like, by
pressing the New Entry button in the logbook window, or by pressing the "L" key on your keyboard.

Prompt Before Saving Each Entry
Unless you check this Prompt... option, these automatically timed entries will be made "in the background" during
program operation:  you won't see the entries being made, but you can read them anytime by opening the logbook.
However, if you'd like a chance to view the data or add some notes, you can check Prompt before saving each
entry.  Every hour (or half-hour), Offshore Navigator will automatically open the Log Entry window for your review.
Add notes if you like, then press Close to add the entry to the logbook.

Notes on Prompting:
• The vessel data shown in the entry window won't change, no matter how long you leave the entry window

open to add notes.  The position, course, and speed are recorded at the time intervals you specified, and
aren't affected by the timing of your Notes.

• It is not possible to cancel an automatically timed log entry once that entry window has appeared.
• The log entry window will remain open until you close it.  If you haven't closed it by the time the next

entry must be made, Offshore Navigator will close the last log entry, adding a note saying "Log entry not
acknowledged."

Require Watchstander Initials
The log entry window provides a space where the watchstander may record his initials.  If you want to ensure that
this space will be filled in, check Require Watchstander Initials.  Offshore Navigator will not allow the watchstander
to close the entry window unless the Initials space is filled in.

Events that Trigger Logbook Entries

Certain events will automatically trigger a log entry. For example, if you lose your GPS connection, or if you enter
an alarm zone, Offshore Navigator will automatically record this event in the logbook. This ensures an accurate
record of important events and conditions during navigation. Since there is no need to review or confirm these
logbook entries, all personnel are free to focus immediate attention wherever needed when such situations arise.
Like all logbook entries, these automatic entries may be viewed at any time in the logbook. Below is a complete list
of these events and accompanying logbook notes.

When this happens: The logbook will record this message:

GPS is unplugged or loses power
"GPS CONNECTION LOST: GPS cable has been
disconnected or GPS has lost power. Position shown
is last known true vessel position."

Not enough satellite data to calculate
vessel position

"INVALID GPS SIGNAL: GPS is still connected, but
position signal has been lost."

GPS position data is regained after a
problem

"GPS SIGNAL REGAINED: Position data again
available."

Switching from Position from GPS to
Position from Simulator (in
Vessel/GPS menu)

"SWITCHED TO SIMULATOR: Vessel icon to be
moved by Simulator. Position shown is last known
true vessel position."

Entering Dead Reckoning mode

"DEAD RECKONING BEGUN: Loss of GPS signal has
prompted Dead Reckoning mode. Position shown is
last known vessel position. Until GPS signal is
regained, position will be estimated using course
and speed assigned for Dead Reckoning."

Beginning GPS navigation (i.e., each
time Position from GPS is selected
from Vessel/GPS menu)

"GPS CONNECTED: Position data in use."

Un-checking Position from GPS in "STOPPED USING GPS FOR VESSEL POSITION:
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Vessel/GPS menu Vessel icon to be moved manually on chart. Position
shown is last known true vessel position."

Man Overboard reported "MAN OVERBOARD REPORTED"

Man Overboard alert canceled "MAN OVERBOARD ALERT CANCELED"

Vessel enters zone of an Entry Alarm "ALARM TRIGGERED by entering zone: [name of
alarm]"

Vessel exits zone of an Exit Alarm "ALARM TRIGGERED by exiting zone: [name of
alarm]"

Vessel exceeds circular range allowed
by Anchor Alarm settings

"ALARM TRIGGERED: Anchor drag."

Offshore Navigator is closed. "OFFSHORE NAVIGATOR STOPPED"

Offshore Navigator is started. "OFFSHORE NAVIGATOR STARTED"

Automatically timed log entry never
acknowledged, even though
Prompting was requested

"LOG ENTRY NOT ACKNOWLEDGED: Log entry
window was automatically closed at [time] to make
room for next scheduled log entry."

Printing the Logbook
You may print the Ship's Log for recordkeeping or reference.  Click Vessel/GPS, Ship's Log to open the logbook,
then press Print.  This will print the logbook Page (24-hour period) that you're viewing in the logbook window.

Official Ship's Log requirements vary in different areas.  Some regulations require paper logs, reviewed and signed
by specific ship's personnel.  For such purposes, a Signature space is provided at the bottom of each printed page.
The ship's name, name of the owner, and date of the log page is also automatically included at the top of each
print.  (This information is taken from Offshore Navigator's Vessel Setup; click Vessel/GPS, Setup, Vessel to
modify.)
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Exporting the Logbook to a Text File

Offshore Navigator allows you to export the ship's log in text file format.  Press the Export button in the logbook
window, and select the date(s) you wish to export.  Each date represents one Page of the logbook.

Exported data may be used in other programs; for example, for spreadsheets or databases. The exported files may
also be e-mailed.

Importing the Ship’s Log into Microsoft Excel
Several Maptech customers have told us that they plan to use Microsoft Excel to view and arrange their exported
data.  For your convenience, we include the following step-by-step procedure for opening mark text files in Excel.
(These instructions were written for Excel97; they may need to be modified for use with other Excel versions.)

1. From Excel’s File menu, choose Open.
2. Browse to the location of your exported text file.  Unless you modified the filename, the exported file is

named “Shipslog_[date].txt.”  (To bring the file into view, you may need to specify All or Text Files under
“Files of Type” at the bottom of Excel’s Open window.)

3. The next window that appears will offer you two choices.  Choose Delimited, and press Next.
4. Under “Delimiters,” check Tabs.  Also, check Treat Consecutive Delimiters as One.  (If your text file

contains two or more tabs back-to-back, this will prevent Excel from creating any unnecessary blank
columns.)  Press Next.

5. In the final window, you may leave the Column Data Format settings as they are (unless you have a
preference here), and press Finish.
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MOB (Man Overboard) Tracking Feature

 
Offshore Navigator is equipped with a Man Overboard tracking feature.  In case of such an emergency, press this
button and Offshore Navigator will mark the location and note the lat/lon, provide the range and bearing to the man
overboard, track the elapsed time, and calculate the time it will take to reach the man overboard from the current
vessel location.
 
To start the MOB tracking feature, press the MOB toolbar button or choose Start MOB from the MOB menu.
Offshore Navigator will place a life ring symbol on the chart, at the location of the vessel when Man Overboard
tracking is started.  A line will join the vessel icon to the MOB life ring location, for quick visual reference.
 
An additional status bar will appear at the bottom of the Offshore Navigator screen.  This is the MOB status bar,
showing the range and bearing to the man overboard.  Elapsed time and time to man overboard are also shown
here.
 

Start MOB 
In the event of a Man Overboard, start Offshore Navigator's Man Overboard tracking feature by choosing
Start MOB from the MOB (Man Overboard) menu.  You can also press the Man Overboard button on the
toolbar.

Locate MOB 
If Man Overboard (MOB) location is off-screen, choose Locate MOB and chart display will center on the MOB
location, indicated by a red-and-white life ring symbol.

To end Man Overboard tracking:
• Press the MOB toolbar button, or
• Choose Cancel MOB from the MOB menu, or
• Right-click on the MOB life ring icon (on the chart), and choose Clear.

 
For safety reasons, a warning window will ask you to confirm the Cancel MOB command before Offshore Navigator
will cancel MOB tracking.
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Datum Warnings/Errors

 

What is datum?

Simply put, datum is a model used for calculating the location of the Earth's center.  This center calculation is used
as a reference point in establishing coordinate locations, like latitude/longitude, on the Earth's surface.

Why does it matter?

There are many different datums.  A coordinate location calculated using one datum may differ by several hundred
feet from the same coordinates calculated from another datum.  Therefore, before relying on coordinate location
information, it is important to know what datum was used in establishing those coordinates.
 
Offshore Navigator's Status Bar provides at-a-glance datum status.  Usually, the Status Bar will read "Datum OK."
If there are any discrepancies you need to know about, the Status Bar will note "Datum Warning" or "Datum Error."
you can then click on the status bar's datum note for further information.  Below are explanations of the Datum
Warning/Error messages.

Overlay Datum Warning

If you import data or transfer data from a GPS to Offshore Navigator, Offshore Navigator needs to know the datum
that was used in creating that data.  Most of the time, Offshore Navigator can determine the coordinates’ datum
and make the necessary adjustments to display the coordinates in their proper position on the chart.

However, if there is any uncertainty about the datum of an overlay (route, mark, track, etc.), Offshore Navigator
will display a warning message.  It is unsafe to navigate using coordinates whose datum is uncertain.  Without
knowing the datum, you cannot be sure if the position indicated by the coordinates is really the location that is
intended.
 
For example, if you attempt to follow a route of uncertain datum, the Status Bar will read "Datum Warning" and will
provide the following message:

 
"Datum Warning:  The datum of this overlay is unknown, making it unsafe for navigational use.  Please verify that
the position of the overlay is correct, then right-click on the overlay and choose Accept Datum as Good."

 

If you cannot solidly confirm the overlay's accuracy by looking at the chart, then do not accept the datum as good,
and do not use that overlay for navigation.
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Chart Datum Warning

WGS84 (World Geodetic Survey of 1984) is the most widely accepted datum, and is a standard datum used in
creating charts for US waters.  If you open a chart that was created using a different datum, Offshore Navigator will
convert it to WGS84, and provide this warning:
 
"Datum Warning:  This chart was drawn using a datum other than WGS84, but Offshore Navigator has converted
the chart to WGS84, the globally accepted datum.  Your vessel and overlays (marks, routes, etc.) are displayed at
their true coordinates, shifted to WGS84 datum.  Your cursor position is indicated either in the local datum of this
chart, or in WGS84- depending on the setting you have specified in Options (under the View menu)."
 
You can rely on all your overlays and coordinate data when using this chart.  The Datum Warning message is simply
a notification that lat/lon data is being given to you in WGS84 datum.
 

Chart Datum Error

In very few cases, a chart may use a datum that Offshore Navigator is unable to convert to WGS84.  The Status Bar
will report "Datum Error" and provide the following message:
 
"Datum Error:  This chart was drawn using a datum that Offshore Navigator cannot process accurately.  Your
vessel and/or overlays (such as marks and routes) may not be displayed at their true coordinates.  Because errors
may occur between charts of different datums, use caution while navigating on this chart."

Datum Calculator
 

Using the Datum Calculator to Convert to Local Datum
The Datum Calculator can convert a set of coordinates from one datum into another.  To open the Calculator, click
Tools, Datum Calculator.

The most common need is to convert coordinates from WGS84 datum (the most popular datum in GPS use) to the
Local datum ( the datum of the chart you're viewing).  When you first open the Calculator, it will automatically fill in
the Latitude and Longitude of the point at the center of the screen, and it will automatically select WGS84 as the
Original Datum (the datum of the coordinates that you want to convert).  You may overwrite the Lat and Lon
fields with your own coordinates, and if your coordinates aren't in WGS84, select their datum from the drop-down
list.  Then, to see this location on the chart, press Plot.  The location of your coordinates will be marked with a red
cross on the chart.  To find that location's coordinates in the Local datum, just hold your cursor over the cross and
read the coordinates in the display at the top of the Offshore Navigator window.
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Advanced Calculations:  Specifying Different Datums
When coordinates are converted, they are shifted from one datum to another.  (The adjustment required to express
a location in a different datum is called datum shift:  a numeric adjustment to the coordinates.)  As mentioned
above, when you first open the Datum Calculator, it is preset to convert coordinates into the Local datum:  the
datum of the chart you are viewing.  To convert to any other datum, press the Advanced >> button.

 

Under Shifted Coordinates, you may specify the datum to which you want to convert the lat/lon, and press Plot
to perform the calculation.  If the location you're converting falls within the boundary of the chart you're viewing,
the location will be marked on the chart by a red cross.  Since your coordinates always represent the same
geographic point regardless of what datum you convert them to, the red cross will remain stationary throughout
your calculations.  The latitude and longitude figures alone will change:  you can read the Shifted
Latitude/Longitude in the Calculator window.

The yellow cross shows your Unshifted Coordinates.  This is intended solely as a visual aid for observing datum
shift when working within the boundaries of the chart you're viewing.  The location of the yellow cross in relation to
the red cross demonstrates the amount and direction of datum shift between the two datums.  For example, if the
yellow (incorrect) cross appears south of the red (correct) cross, this indicates that your Latitude figure was
augmented in order to be plotted properly.  (If you had NOT converted your latitude and longitude figures--if you
had simply used your original figures without applying any shift--your coordinates would be improperly plotted and
if you used them for navigation, you would be south of where you actually wanted to be.)
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Adjusting Offshore Navigator's Datum Setting
Offshore Navigator displays coordinates either in WGS84 datum, or in the Local datum (whatever datum was used
in creating the chart you are viewing).  T o adjust Offshore Navigator’s datum setting, click View, Options and
select the Chart Display tab.  To find out the datum of the chart you’re viewing, right-click on the chart and
choose Chart Info.
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CHAPTER 5:  ON-WATER MODE (FULL VERSION ONLY)

About On-Water Mode

Designed for Navigation
In On-Water Mode, Offshore Navigator's standard menus and controls are removed from the chart window.  They
are replaced by a smaller set of buttons and readout panels.  These buttons use large-print labels and simple
images, to help you easily identify the tools and data that you're most likely to need during actual navigation.  This
pared-down, simplified control panel makes it easier to glance at the screen and find what you need, in all types of
cruising or sailing conditions.

Entering On-Water Mode
To enter On-Water Mode, press the On-Water button in the lower left corner of the Plan Mode screen.
(Plan Mode is Offshore Navigator's standard mode.)

Returning to Plan Mode
Press the Plan button when you want to end On-Water Mode and return to Plan Mode (Offshore
Navigator's standard mode).
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Adjusting Chart Display

Selecting/Changing Charts

The chart title, type, ID and scale are listed along the top of the screen.  Next to each of these is a drop-down
menu, so you can select a different chart based on title, chart type, etc.

Chart Details

In the lower left corner of the screen, a note window tells you whether the soundings on the chart are given in feet,
fathoms or meters.

Just as in Plan Mode, a datum status note is provided.

Adjusting the Chart Display
Square buttons across the bottom of the screen make up the rest of the controls:

Scale In
Opens the next-larger scale chart available (for closer detail).

Scale Out
Opens the next-smaller scale chart available for this area, providing a wider view.

Maximizes the chart viewing area, by removing/shrinking controls.  Press View again to restore all
controls.

Opens the Chart Overview window as an inset in the top left corner.  The Overview Window gives you
a view of the entire chart.  The area being shown on your screen is outlined in red.  You can drag this
red outline across the overview to view a different area of the chart.



98

Positioning the Vessel

Locating the Vessel Icon
Press Vessel to center the screen on your vessel location (same as the Locate Vessel button in Plan
Mode).  Your position is marked by a vessel icon on the chart.

Positioning the Vessel Icon
To represent your actual vessel location, Offshore Navigator relies upon
position data received from your GPS.  All you need to do is make sure your
GPS is turned on, is properly connected, and is receiving a valid position fix.

The vessel icon location is accurate ONLY as long as your GPS is on and receiving an accurate signal.  To check
whether Offshore Navigator is receiving position data from your GPS, check the vessel position status note in the
lower left corner of the screen.  GPS:  FIX means that the vessel icon represents the lat/lon received from your
GPS.

The GPS status note tells you at a glance whether the vessel icon represents your actual GPS location.  If it doesn't,
you'll see one of these notes instead:
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If your GPS signal is lost for any reason, the note will read GPS:  ESTIMATED.  When this happens, Offshore
Navigator can continue to move your vessel icon along an estimated course, using Dead Reckoning (requires
setup—see page 58).

If your GPS isn't turned on and connected, you can click-and-drag the vessel icon on the chart.

 

You can also use the Simulator to control vessel icon movement and direction.

Tracking Your Progress

Marking Your Position
Anytime you want to mark your location for future reference, press the Position Mark button.  (For
example, to mark the location of a submerged rock, school of fish, etc.)  This will create a mark at
the location occupied by your vessel at the time that the button is pressed.  This Position Mark will
remain in place on the chart even after your vessel moves away.

The only difference between Position Marks and standard marks is in the way they're created.  Position Marks have
all the same characteristics as standard marks:  you can rename them, change their symbols, etc.  In the Mark List,
a Position Mark is indicated by an asterisk (*) after its name.  (To view the Mark List and edit your marks, you must
return to Plan Mode.  Press the Plan button to leave On-Water Mode and return to standard Plan mode.)

Recording Your Progress
To lay down a track line along your course as you cruise, press Track.  The track line connects symbols "dropped"

at regular intervals as your vessel moves.  Your Track will be saved on the chart.

To set the symbol interval and other track recording options, press Plan to return to Plan Mode and then choose
Vessel/GPS, Tracks, Record.  See page 66 for details.  (Note:  In order to use this tracking feature, your GPS
must be on and connected to Offshore Navigator.)

MOB:  Man Overboard Tracking
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In the event that someone falls overboard while you're cruising, press this button immediately to
start Man Overboard Tracking.  As soon as the button is pressed, Offshore Navigator will drop a life
ring symbol mark at the location of your vessel.  A panel will appear at the bottom of the screen,
with bearing information to guide you directly back to the MOB location (marked by the life ring).  A
line will join your vessel icon and the MOB location, serving as a visual aid.  In addition, a timer will
count down the time elapsed since the MOB button was pressed.  (This information will be invaluable

in describing a victim's condition in the event that emergency treatment is required.)

When the Man Overboard emergency is ended, press the MOB button again.  The information display and the life
ring symbol will be removed.

Spherical Horizon View

Spherical Horizon View, an option provided in On-Water Mode, presents each chart as a curved image, much like a
globe.  This chart view mode is designed for use when you're Following your vessel:  when the chart view
automatically follows your vessel as you move showing you where you are at all times.

Used during navigation, Spherical View offers a double advantage:  it gives you a broad overview of the chart you're
using, without compromising detail in your immediate area.  The area in the "foreground" is shown in crisp focus, so
you can read nearby depth marks, notes, and other chart details.  The rest of the chart is visible in the distance, so
you can see what lies ahead.  (In the picture above, several chart outlines indicate areas where more detailed
charts are available.)  As your vessel moves across the chart, the chart scrolls towards you, so that your vessel
location is always shown in clear detail.
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To enter Spherical Horizon View, press the Sphere button.  Press it again to toggle back to flat chart view.

Notes:

• In order to use Spherical Horizon View, your computer's Colors setting must be at least 16-bit ("High
Color").  To adjust your color setting, right-click on your desktop and choose Properties, Settings.

• Spherical Horizon View works best on computers with at least 128 MB of RAM.

Setting Course

Creating a "Go To"

Press this button to create a Go To route straight to any location that you select on the chart.  Just
press the Go To button and then click on your destination.  Offshore Navigator will place a waypoint
(#1) at the location you click.  When you create a Go To and specify your destination, you can also
take advantage of the constantly updated information provided by the data windows, to guide you
towards the location that you clicked.



102

Data Windows

Just as in Plan Mode, Offshore Navigator can provide constantly updated data
readings for your reference while you cruise.  The data window panel may be
dragged to any area of the screen.

In order for data windows to appear in On-Water Mode, they must first be
turned on in Plan Mode (Offshore Navigator's standard operating mode).  To
activate data windows, check the Data Windows checkbox in the View menu.

To configure your data windows and choose what information to include, choose
Setup, Data Windows from the Vessel/GPS menu.  (Or, you can just click on
any data window.  Right-click if in Plan mode, left-click in On-Water Mode).  See
page 67 for a list of available data.
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Contour Chart Control

 

When viewing contour charts, an optional control may be used for more precise chart manipulation.  The Contour
Chart Control lets you rotate the chart to any angle, tilt it up or down for a better view, and zoom smoothly in and
out.

To activate the Contour Chart Control when in On-Water Mode, press the Control button.  The
Contour Chart Control will appear in the upper right corner of your screen.

The top section of the control lets you make major viewing angle adjustments quickly and
precisely.  The chevron shape in the center represents your vessel, bow facing forward.  Click any
arrow to "look" in that direction:  for example, to look at the contours to starboard, click the arrow
pointing to the right; to look straight ahead, click the arrow that's pointing in the same direction
as the vessel icon, etc.

The "spin" ball lets you make more minute adjustments.  Click any point on the spin ball to rotate
or tilt your viewing angle in that direction.  To view the chart from higher up, click the up-arrow
on the top of the spin ball.  To move your viewpoint around to the left, click the left arrow, etc.
To continue spinning, just hold the arrow down.

Finally, the plus and minus buttons let you zoom in (+) and out (-) on the chart.  Hold either
button down for a continuous zoom.
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Removing the Contour Chart Control
In On-Water Mode, the Control button acts as a toggle, turning the Contour Chart Control on and off.  Just press
Control to activate, or remove, the Contour Chart Control.

On-the-Water Mode Shortcut Keys

Use your keyboard for shortcuts to several On-Water Mode features:

MOB (Man Overboard):  F5
Starts Man Overboard tracking.

Tile Contour Chart Window:  C
Opens Contour Chart coverage for the location you're viewing.

Locate Vessel:  V
Centers the screen on your vessel location (opens a new chart if necessary).

Plan Mode/On-Water Mode:  O (works as toggle)
Toggles between On-Water Mode and Plan Mode

Zoom In/Out:  + (in), - (out)
If you have one, you can also use your Mouse Wheel:  spin towards screen to zoom in, spin towards self to zoom
out.

Moving Around the Chart:  4 Arrow Keys
--> to pan to the right, <-- to pan left, etc.

Maximize Active Window:  X
Maximizes active chart window and also removes navigation panel/status lines from bottom of screen for maximum
display area.
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CHAPTER 6:  ROUTES

What is a Route?

A route is a series of waypoints, connected in sequence along a path of travel.  (Waypoints are individual
latitude/longitude locations.)
 
In Offshore Navigator, routes are displayed as symbols and lines on the charts.  You can adjust the characteristics
of each route (symbol and line color, symbol shape, display of waypoint name and number, etc.).
 

The Route List

The Route List window shows all your routes.  Click on a route name to highlight it.  There are several options
available from the Route List window:

 You can edit waypoint symbol, line color, etc.  for the route you highlighted (press Edit);
 Select a route to follow with your vessel (press Follow);
 View a route's location on a chart (press Locate).
 Follow a route in Reverse
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 Show All or Hide All routes on the screen
 Use the Route Plan window to see a breakdown of the trip, including estimated fuel consumption per route

leg at various speeds, duration of each leg of the route, estimated arrival time, etc.
 Delete individual routes or print a list of all your routes.

 

Route Setup
 

 
Choose Routes from the Route menu and press the Setup tab to set default properties for Offshore Navigator to
use when you create routes.
 
The Route Setup options let you decide how your routes should look and act.  Offshore Navigator will use these
settings for new routes.  These default settings can be changed at any time, and of course you can always edit
routes individually if you need to make changes.

• Display:  When this is checked, your routes will be included in the chart display.  If you want your routes
to be hidden from view, uncheck Display.

• Lock:  Check Lock to prevent accidental movement of your routes and waypoints.  When Lock is
unchecked, you will be able to move routes by clicking-and-dragging.
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• Display Range/Bearing:  The range and bearing from each waypoint to the next will be included on the
chart, alongside each route leg line.

• Display Waypoint Numbers:  When this is checked, each waypoint will be identified on the chart by a
number.  Uncheck this option if you prefer to use unnumbered symbols instead.

• Enable End Route Alarm:  When following a route, Offshore Navigator will notify you when you have
reached the end of the route.

• Enable Waypoint Vicinity Alarms:  For use during navigation.  Offshore Navigator will notify you as you
near each waypoint.  The Diameter range controls the range at which Offshore Navigator will notify you:
in this example, the alarm is triggered when the vessel comes within .01 NM (nautical miles) of the
waypoint.

• Enable Waypoint Achievement Alarms:  When your vessel has reached a waypoint, Offshore Navigator
will notify you.  The Diameter range tells Offshore Navigator how close the vessel must come to the
waypoint before the alarm is triggered (adjust the diameter according to your personal preference).

• Background Color; Preview:  The background and text color choices are for use with waypoint
numbering and range/bearing data.  The Preview pane lets you see how your choices will look.  (Uncheck
the Background Color checkbox if you prefer a transparent background.)

• Waypoint Symbol:  Five waypoint symbols are available; press Change and then click on the symbol you
want.

• Line Color:  Pick a color to use for the lines that join the waypoints.
• Color of Selected Line:  The lines of a route can change color when that route is selected (for example,

when you click on a route or when you are following the route).  Pick a line color that will signify when a
route is selected.

• Enable Routes to be Dragged:  You can move individual waypoints by clicking and dragging, but the
Enable Routes to be Dragged option lets you move an entire route at once, by clicking on a line and
dragging the route to another location.

• Prompt for Route Properties:  When this is checked, Offshore Navigator will automatically prompt you
to assign a new route's properties as soon as you finish creating the new route.  The Route Properties
window will automatically appear after you save the route.
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Route Properties

 
You can adjust a route's characteristics in the Route Properties window.  To open the Route Properties window:

• Highlight the route's name in the Route List and press Edit:  or
• Right-click on one of the route's waypoints and choose Route Properties.

 
The Display tab, shown above, lets you choose a waypoint symbol, line color, and other features that control how
the route looks and acts.  The Waypoints tab lets you edit waypoints’ coordinates or insert new waypoints by
assigning them coordinates.  The Alarms tab lets you adjust the diameter for the Waypoint Vicinity and Arrival
Alarms.  For details on these alarms and other Properties options, see Route Setup on page 106.
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Route Plan

The Route Plan window lets you modify a route.  For example, you can assume different speeds for different legs of
the route, or decide how much time you want to spend at each waypoint.  Offshore Navigator takes your route plan
and automatically calculates how long the trip will take, how much fuel you will use, etc.  In this way, you can
experiment with a route before you even get on the water.
 
The Last Trip tab lets you see route plans for previous cruises of this route.
 
The data columns in the lower portion of the window may be rearranged to your liking.  Each row represents one
route leg.  Some of the columns are not visible in the image above; here is a complete list of available Route Plan
data:

• Leg Number
• Starting Waypoint
• Start Lat/Lon
• Ending Waypoint
• Distance (traveled so far)
• Distance Summary (total trip distance)
• Bearing (of leg)
• Speed (of leg)
• Time (spent so far)
• Time Summary (total trip time)
• Completion (date and time)
• Pause (how much time spent in Pause mode after this leg)
• Fuel (consumed during this leg)
• Fuel Summary (total fuel consumption)
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You don't need to use all the fields; you can choose the ones you want to include in the Route Plan by pressing the
Columns button.

Route Templates
 
If there is a harbor, channel, or other area through which you travel frequently, you can create a route template for
the course that you typically follow.  You can use this route template as the basis for other routes that you create in
the area.
 

 
The route template shown above has square yellow waypoints.  Two routes have been built onto this template.

Creating a Template
Use the Route Tool to create a route on the chart, then right-click and choose Save as Template.  After you save
the template, the Route tool is still active.  If you want to immediately build a route from this template, continue to
click and add waypoints.  Otherwise, right-click again and choose Save to close the Route tool.

Converting a Template into a Route
From the Route menu, choose Template List.  Select the template you want to use, and press Convert to Route.
The template will appear on the screen, and the cursor will be in Route Tool mode, with a line attaching it to the
final template point.  Simply click wherever you want to add waypoints to the template, to form a new route.  When
you have finished, right-click and choose Save.  The original template will remain as it was, and your new route will
be overlaid on top of it, covering the entire planned course.

Note:  If you just want to view a template, without building a route onto it, choose Template List from the Route
menu, select a template, and press Locate.  This will show you that template's chart location, without activating
the Route tool.

Following a Route

Following a route in Offshore Navigator means that the vessel icon will move along the route overlay to represent
your progress during a cruise.  You can follow a route using your GPS during actual navigation on the water, or you
can use the Simulator (useful for planning, when you're not actually moving).
 
Highlight a route and press Follow, then select a Position From option from the top of the Vessel/GPS menu.
Offshore Navigator will move the vessel icon to represent your progress along the route.
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• Position from GPS:  If you are on the water and cruising, choose Position from GPS from the
Vessel/GPS menu, and your position will be marked on the charts and updated every three seconds.
Offshore Navigator receives position data from your GPS and places your vessel at the coordinates
received.  When Position from GPS is checked, you may also follow a route using your Autopilot (see page
112).

• Position from Simulator:  This lets you simulate vessel movement to help you plan a cruise in advance-
even before you get on the water.  Your vessel icon is moved according to the speed and current set/drift
conditions that you specify in Simulator Setup (see page 84).

When you're following a route, the Follow button is relabeled Abandon.  If you decide to stop following the route,
Abandon it either by pressing this Abandon button, or by right-clicking on the route and choosing Abandon
Route.  To temporarily pause vessel tracking progress, right-click on the route and choose Pause Route.  This will
let you make a temporary deviation, then pick up again where you left off.  (Offshore Navigator will continue to
move your vessel across the chart; it just won't compare your course to the planned route.)
 
Notes:  To bring the route into view on the screen, Route List from the Route menu, highlight the route name,
and press the Locate button.

Following a Route using the Simulator

(See page 84 for more information about the vessel movement Simulator.)

When you're following a route, you have two choices for how the Simulator should work.  Under Active Route,
check whether to Only use route plan headings, which lets you see what would happen if the vessel's course
were NOT corrected for the effect of a current, or whether to Also apply vessel data.  The latter allows you to
make adjustments to your course as necessary, providing a hands-on means of determining what corrections would
be required under different conditions.

Following active route:  This is automatically checked if you're following a route.  If you want to pause the route,
just uncheck this box.  Check it again to resume the route.

Step-by-Step Instructions
1. Locate the route that you want to follow, then right-click on it and choose Follow.
2. Next, place the vessel icon near the start of the route.  (To do this, right-click near the start of the route

and choose Put Vessel Here.)
3. If you want to record the vessel's progress, choose Vessel/GPS, Tracks, Record
4. Hold the cursor over the route.  The cursor will change to a cross shape.  Right-click, and choose Follow.

A route line will join the vessel to the route's first waypoint.
5. From the Vessel/GPS menu, choose Setup, Simulator.  Check the Following active route checkbox (if it

isn't already checked).
6. To the right of the checkbox, there are two choices.

• Only use route plan headings lets you see what would happen if the vessel's course were NOT
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corrected for the effect of a current.
• Also apply vessel data lets you make heading adjustments as necessary to compensate for the

effect of the current.  This is a "hands-on" way to determine how much of a correction is needed under
different conditions.

7. Under Current, specify Set (the direction of the current) and Drift (the current's speed).
8. Press OK.  On the chart, the vessel will begin to move.  Choose Setup, Simulator from the Vessel/GPS

menu when you want to make changes to the Simulator settings.  To pause the simulation, uncheck the
Position from Simulator at the top of the Vessel/GPS menu.  (A check next to this menu option indicates
that the Simulator is in use.  Uncheck it to pause simulation; recheck to restart.)

Following a route, relying solely on route plan headings, with a 3 MPH current at 165° True.

In the image above, the vessel's course is shown by the red track line.  Without any course corrections, the vessel's
location upon route completion is nearly a quarter mile south of the final waypoint.  By looking at this result, you
can gauge the amount of correction needed.  Alternatively, you can run the simulation again, this time checking
Also apply vessel data, and actually make corrections as the vessel icon moves.

Following a Route with Autopilot

Offshore Navigator can send route data, along with position data from your GPS, to your Autopilot device.

1. If you haven't yet set up your Autopilot, choose Vessel/GPS, Setup, Autopilot to configure settings for
use with Offshore Navigator.  (See page 59.)

2. Next, make sure your Autopilot device is turned on.
3. To start sending data to the Autopilot, check Send Data to Autopilot, found under the Vessel/GPS menu.

Important:  This alone will not necessarily ensure that communication is established.  You must verify that your
Autopilot is receiving the data that Offshore Navigator is sending.

• As always when navigating with Autopilot, as you finish each leg of your route, your Autopilot will request
that you confirm each waypoint as it is achieved, before setting course for the next waypoint.

• If you like, you may specify information you'd like to receive from your GPS and pass through Offshore
Navigator without modification, directly to your Autopilot (see page 60).

• In the event that your GPS signal is lost, Offshore Navigator can send estimated course data to the
Autopilot, using Dead Reckoning (see page 58).
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CHAPTER 7:  INFORMATION TO AID NAVIGATION

Tide Stations

Tide Station List
 
Maptech ChartKit CDs edition 3.0 and higher include tide graphs for several tide stations within each chart region.
To browse a list of the tide stations and select one to view on the screen, choose Tide Station from the Locate
menu.
 

 
The stations are represented by icons on the charts.  Each icon is labeled with the present tidal height, and includes
an arrow that indicates whether the tide is ebbing or flooding.  (Offshore Navigator uses your computer's system
clock to gauge the present tidal conditions, changing the icons’ appearance accordingly.)
 
Right-click on an icon to read the station name, view the related tide graph, or get additional data about the station
(Properties).
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Tide Station Icons

Standard Icons
 

 
The icons that indicate the tide station locations also indicate the stage and height of the tide.  The icons change in
appearance to reflect the present conditions:
 

 
Note:  Offshore Navigator uses your computer's system clock to get the time and date, in order to show present
tidal conditions.  Therefore, the accuracy of the tide readings depends on the accuracy of your system clock.
 

 Smaller Icons are Sometimes Used 

  Sometimes the scale of a chart, or the high number of tide icons in one area, make it hard to use the
standard tide icons to indicate each station accurately.  In these cases, Offshore Navigator uses a smaller version of
the tide icon (shown above).  These smaller tide icons always look the same regardless of tidal conditions, so you
will need refer to each station's tide graph for further information.  Alternatively, you can zoom in or scale in until
there is room for Offshore Navigator to display the standard tide icons.
  
Right-click on an icon to read the station name, view its tide graph, or get additional data about the station
(Properties).
 



115

 

Tide Graph
 

 
Maptech ChartKit CDs edition 3.0 and higher include tide graphs for several tide stations within each region.  The
stations are represented by icons on the charts.  To view a tide graph, just right-click on a tide station icon and
choose Tide Table.  The graphs provide the time and estimated water height of predicted high and low tides.
 

Interpreting the Tide Graph
The tide graph shown above is the standard format for conveying tide fluctuations hour to hour.  The vertical axis
shows the height of the tide.  Time progression moves from left to right, and is shown in hourly increments on a 24-
hour scale, with afternoon and evening hours represented as 13 (1 PM) through 23 (11 PM).  Zero is midnight.
 
In the tide graph, red indicates when the tide is flooding (rising); blue shows when the tide is ebbing.  The dark and
light gray shading above the line distinguishes day from night.
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Checking Different Dates and Times
When you first open the tide graph, it shows the present conditions.  (It gets the date and time from your
computer's system clock).  There are several ways to adjust the date and time being displayed.  As you change the
day or hour, the graph scrolls to represent tidal conditions at the specified time.  All time and date readings are
updated simultaneously (in other words, if you change the date, the day of the month will change too).
 

Tide Graphs from BA (British Admiralty) Charts
Tide graphs for stations on charts produced by the British Admiralty contain some additional data:

• Datum of Soundings:  The point used as a base in determining tide height. Tidal datum is a local
measurement., also known as Datum height, and is usually the level of low water at ordinary springs in this
region, or sometimes mean low (or lower low) water. This figure is printed on most paper nautical charts.

• Reference Place:  The location where this measurement was taken.
• Show Means on Graph:  Check "Show Means on Graph" to include yellow lines through the graph at mean

water levels.
• MLWS:  Mean Low Water Springs.  The yearly average low water height measured at spring tide.  Spring

tide is the period during the moon phase cycle when the range of tide is at its maximum (that is, when the
difference between low tide and high tide is greatest).

• MLWN: Mean Low Water Neaps.  The average low water height measured at neap tide.  Neap tide is the
period when the range of tide is at its minimum (when the difference between the levels of low tide and high
tide is smallest).

• MHWN: Mean High Water Neaps.  The average high water height measured at neap tide.
• MHWS:  Mean High Water Springs.  The average high water height measured at spring tide.

Tide Table
 

 
For most tide stations, the Tide Graph window includes a button labeled Tide Table, which leads to a text version
of tide data for that station. Data is arranged in columns headed by tabs: Year, Month, Date, Day, time, Height, and
whether the tide is ebbing or flooding. Predictions are given for each turn of the tide over a period of several years;
use the scroll bar to find the date(s) you want.

Note on BA (British Admiralty) Charts:  Due to a lack of consistent tabular data, tide tables are not available for
tide stations on BA charts.  Use the Tide Graph instead to research past and future conditions.
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Tide Station Properties
 

 
The Properties window contains information about a particular tide station.  This window appears when you right-
click on a tide icon on a chart, and choose Properties.
 
• Reference Station:  The station used as a reference to construct the tide graph for this station (relative to the

reference station).
• Distance from Reference Station:  Distance between this station and its reference station.
• Mean Tide Range:  The difference between levels of mean high water and mean low water, at a given place.
• Mean Tide Level:  The average water height at this location.
• BSB Region:  The Maptech ChartKit CD region containing this station.
• Spring Range:  During a full moon or a new moon, the tide's range is increased.  The spring range is the

difference between the average high waters and the corresponding average low waters during these periods of
increased range, at this particular location.

• Tidal Datum:  The point used as a base in determining tide height.  Tidal datum is a local measurement., also
known as Datum height, and is usually the level of low water at ordinary springs in this region, or sometimes
mean low (or lower low) water.  This figure is printed on most paper nautical charts.

Tide Station Properties for Stations on BA (British Admiralty) Charts
Tide Station Properties for stations on charts produced by the British Admiralty provides some additional data:

• BA Region: The Maptech chart CD region(s) containing this station.
• MHWS:  Mean High Water Springs.  The average high water height measured at spring tide.
• MLWS:  Mean Low Water Springs.  The yearly average low water height measured at spring tide.  Spring

tide is the period during the moon phase cycle when the range of tide is at its maximum (that is, when the
difference between low tide and high tide is greatest).

• MHWN: Mean High Water Neaps.  The average high water height measured at neap tide.
• MLWN: Mean Low Water Neaps.  The average low water height measured at neap tide.  Neap tide is the

period when the range of tide is at its minimum (when the difference between the levels of low tide and high
tide is smallest).

• Approximate Center of Station Area:  This latitude/longitude roughly represents the center of the area
covered by this tide station.

 



118

Current/Tidal Stream Stations

Current/Tidal Stream Station List
 
Maptech ChartKit CDs edition 3.0 and higher include data on various current stations within each region.  To browse
a list of the current stations and select one to view on the screen, choose Current/Tidal Stream Stations from
the Locate menu.  (“Tidal Stream” is the preferred term in British English, and stations on charts produced by the
British Admiralty are known as tidal stream stations.)
 

 
The stations are represented by icons on the charts.  Each icon is labeled with the present speed of the current, and
includes an arrow that indicates whether the current is ebbing or flooding.  (Offshore Navigator uses your
computer's system clock to report the present conditions, changing the icons’ appearance accordingly.)
 
Right-click on an icon to read the station name, view the related current graph, or get additional data about the
station (Properties).

 

Current/Tidal Stream Station Icons
 
Current stations are marked by icons on the charts.  There are several versions of the current icon.
 

 Standard Current Station Icons
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The picture above illustrates the different phases of the standard current icon.  Each icon changes in appearance
over the course of the day, to reflect the present conditions at that current station.  Offshore Navigator uses your
computer's system clock to make these calculations.  The accuracy of these symbols depends on the accuracy of
your computer's clock.
 
Amount of Color
You may also notice that some current icon arrows are longer than others.  The longer icons represent currents with
a greater range of speed (currents that can be quite fast).  The outlines of these icons are not always completely
filled in with color.  They fill with color as the current builds up speed.
 
When the current is building up speed, the arrow outline is not yet completely filled with color.  When the current is
moving very quickly (at or near maximum speed), the arrow symbol will be completely filled in.
 

 

Caret Symbol in Icon
When a caret symbol (>) is visible within the current station icon, the current's speed is
increasing.  (When there is no caret, the speed is decreasing.)

Tidal Stream Icons on British Admiralty (BA) Charts
For European areas where chart coverage and tide/current data is provided by the British Admiralty, current
stations are known as Tidal Stream Diamonds. "Tidal stream" is the preferred term (in place of "current") in British
English, and the station locations are referred to as "diamonds" because they are indicated by diamond-shaped
symbols on paper BA charts.

These tidal stream icons are based on the same arrow outline, but instead of
varying between red and blue, the arrows are always red. This is because most of
the tidal streams shown are rotary in nature. In rotary streams, there is no
noticeable ebb or flood, as the water flow fluctuates more in direction than in
speed. The arrow rotates to indicate the direction of water flow. When flow is
negligible, the icon is shown as a double-sided arrow, or square.

The water speed label also includes a diamond symbol with the station letter, which differentiates secondary current
stations in a given vicinity. Under this naming system, secondary stations are named for their primary reference
station, the ID of the most detailed chart showing the station, and a letter. For example, Ullapool BA2209 Tidal
Diamond B is based on the Ullapool primary station, may be seen on BA chart 2209, and is the second of two
reference stations found on that chart--it is therefore assigned the letter "B." 

  No Data for Icon, but Consult Tide Graph/Tidal Stream Diagram for Information
For some stations, lack of consistent tabular data makes it impossible to display continually updated conditions on
the icon itself.  However, you may consult the station's Tide Graph or Tidal Stream Diagram for information.
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Smaller Icons are Sometimes Used

 
 

Sometimes the scale of a chart, or the high number of current icons in one area, make it hard to use the
standard current icons to indicate each station accurately.  In these cases, Offshore Navigator uses a
smaller version of the current icon (shown above).  These smaller icons always look the same regardless
of current conditions, so you will need refer to each station's current graph for further information.

Alternatively, you can zoom in or scale in until there is room for Offshore Navigator to display the standard current
icons.
 

Current Stations for which No Current Graph is Available
There are a few types of currents that are not represented in current graph format.  These current stations are
marked by particular icons.  Though no graph is available, the icon itself gives you some general information about
the type of current at that location.
 

WV:  Weak and Variable.  A current is classified as "weak and variable" when its maximum velocity is
below 0.3 knots per hour- in other words, too weak to provide a practical measurement.  In such cases,
the current graph and table will note the current's Weak and Variable classification, and will not provide
speed data for flood or ebb.

The same current may at other times become strong enough to lose this "weak and variable" classification, in which
case the current graph/table will provide current speed data for this station.
 

ROT:  Rotary.  A rotary current flows continuously, and its direction changes through all points of the
compass during the tidal period.  Typically, rotary currents are found offshore where there are no barriers
to restrict the flow of the current.  Except where affected by local conditions, the direction of change is
clockwise in the northern hemisphere and counter-clockwise in the southern hemisphere.

NEG:  Negligible.  Although the current is detectable, its speed is too slight to provide a practical
measurement.

UNI:  Unidirectional.  Often occurring at rivers or during floods, unidirectional currents only flow in one
direction.

   IRR:  Irregular.
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Current Graph
 

 
Current Graphs provide data on the type, speed, and direction of the current at each current station.  To view a
station's graph, right-click on any current station icon and choose Current/Tidal Stream Graph.
 

Interpreting the Current Graph
Current graphs are very similar to tide graphs.  The graphs show fluctuations in the current's speed and direction,
hour to hour.  The vertical axis shows the speed of the current.  Time progression moves from left to right, and is
shown in hourly increments on a 24-hour scale, with afternoon and evening hours represented as 13 (1 PM)
through 23 (11 PM).  (Zero is midnight.)
 
The horizontal line through the center of the graph indicates a speed of 0 knots (slack water).  Where the line peaks
above the center line (dark shading), the current is flooding.  The valleys (lighter shading) between the peaks show
when the current is ebbing.
 

Checking Different Dates and Times
When you first open the current graph, it shows the present conditions.  (It gets the date and time from your
computer's system clock).  All 24 hours for today's date are shown, and a vertical dotted line indicates what time it
is now.
 
There are several controls you can use to adjust the date and time being displayed.  As you change the day or hour,
the graph scrolls to represent tidal conditions at the specified time.  All time and date readings are updated
simultaneously.  (In other words, if you change the date, the day of the month will change too).
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Tidal Stream Diagram (BA Charts)

For charts produced by the British Admiralty, current data is shown in a Tidal Stream Diagram.  ("Tidal stream" is
the preferred term in British English.)  This tidal stream data is obtained from the British Admiralty.

The direction and drift ("speed") of water flow are measured and monitored at specific tidal stream stations.   Since
most of these stations are located offshore in water over five fathoms deep, nearly all indicate a rotary stream.

Rotary Stream
Closer to shore, water typically flows in a predictable cycle ranging between two extremes of drift:  flood (highest
speed) and ebb (lowest speed).  For the most part, the flow is bi-directional, reversing at ebb.  But in a rotary
stream, the stream drift does not fluctuate as greatly, while the direction of flow may shift through all points of the
compass.  To better portray these directional changes, rotary tidal stream data is shown not in a graph, but in a
diagram.

Interpreting the Diagram
The tidal stream diagram shows the direction of stream.  The arrow points in the direction
in which the water is flowing.  The level of red color in the arrow outline indicates drift:  the
more red, the faster the stream.

Times when drift is negligible or nonexistent are known as slack water.  Since the water
flow is so slight, no clear direction is perceptible.  At such times, the arrow will change to a
double-pointed graphic.
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Predicting Conditions
The column on the right side of the window provides hourly stream direction and drift readings.  To find stream
predictions for a specific date/time, use the date/time controls above the diagram.

The pair of left- and right-facing arrows below the diagram let you cycle quickly through recent conditions and
upcoming changes:  clicking either arrow will adjust the diagram by a five-minute increment.  Hold either arrow
down to view changes in progression.

Current Table
 

The current graph window includes a button labeled Current Table, which leads to a text version of current
readings for that station.
 
Data is arranged in columns headed by tabs:  Year, Month, Date, Day, Time, Speed, and whether the current is
ebbing, flooding, or at slack water.  Predictions are given for each turn of the tide over a period of several years;
use the scroll bar to find the date(s) you want.

 Tidal Stream Table (BA Charts)
For current (tidal stream) stations on British Admiralty charts, this table provides Direction of flow instead of
Status.
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Current Station Properties
 

 
The Properties window contains information about a particular current station.  This window appears when you
right-click on a current station icon on a chart, and choose Properties.
 

• Reference Station:  The station used as a reference to construct the tide graph for this station (relative
to the reference station).

• Distance from Reference Station:  Distance between this station and its reference station.
• BSB Region:  The Maptech ChartKit CD region containing this station.
• Flood Direction:  The bearing of the current when flooding.
• Max Flood:  Maximum speed attained by the current when flooding.
• Ebb Direction:  Bearing of current at ebb.
• Max Ebb:  Maximum speed attained by current at ebb.

Tidal Stream Station Properties (BA Charts)
For current (tidal stream) stations on British Admiralty charts, no Ebb or Flood information is provided, since most
such stations represent a rotary stream, for which no definite ebb or flood is apparent.
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Place Name Search

 
 
Most Digital ChartKit Regions are equipped with an extensive database of U.S. place names, through which you can
search for areas of interest.  These places and categories are taken from the Geographic Names Information
System (GNIS) developed by the US Geological Survey (USGS).
 
To search for a name, choose Place Names from the Locate menu, then type a word (or portion of a word) in the
Search window.  You can also scroll through the Place Names list, or rearrange the order of Place Names by double-
clicking on any of the headings (Name, Feature type, Lat, Lon).
 
If your Place Names window is blank, you need to set up your Place Names.
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Setting Up the Place Names Database

Before you can use Offshore Navigator's extensive Place Names database, you need to set it up.  (Setup is also
required if you have more than one ChartKit CD, and you want to search a different region.)  Choose Place Names
from the Locate menu, and select the Setup tab.

Check and Highlight the Region File That You Want to Use
Each CD's Place Names data is stored in a file named for the region covered.  (For example, the filename
"g_reg2.dat" indicates Place Names data for ChartKit Region 2.) The Place Names Setup window lists all available
data files, both Files on CD and Files Installed on Hard Drive.  From one of these lists, check and highlight the file
that you want to use.  Make sure that the file is not only checked, but also highlighted in blue.

(If you select a file from the Files On CD list, that file will be copied to your hard drive, for easy access in future use.
This ensures that any Place Name data that you ever use will be on hand when you need it again.)

Feature Filter
A list of all categories of landscape features lets you narrow down the search possibilities.  If you are only interested
in certain categories, you can select particular categories and exclude the ones you don't need right now.

Press "Load Selected File" to Load the Place Names Data
Once you have made your selections and are ready to load the database, press Load Selected File.  (Answer Yes
to the confirmation message.) The file that you selected will be ready for your use.

Note:  The Place Names data will remain available until you specify a different Place Names data file, or until
you start Offshore Navigator with a different CD in your drive.  (When a CD is present at Offshore Navigator
startup, its Place Names data is automatically loaded for your use.  If you have more than one CD drive,
remember that Place Names data will only be automatically loaded from the drive that was specified as the
default drive, during program installation.)
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Place Name Properties

You can right-click on a Place Names icon and choose Properties for additional data about the location it marks.
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Marine Facilities Search

 
 
Most Digital ChartKit Regions  feature a searchable list of marine facilities for U.S. regions.  Search for a marina or
service station by name or keyword, or view the list in order of name, latitude or longitude.  To go directly to a
marine facility's chart location, double-click its name in this list.
 
If your Marine Facilities list is empty, you need to set up your Marine Facilities.  See page 130.
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Marine Facility Properties

Right-click on a Marine Facilities icon and choose Properties for additional information, including telephone number
and a list of available services.
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Setting Up the Marine Facilities Database

In most cases, your Marine Facilities data is automatically copied to your hard drive.  This lets you do a Marine
Facilities search in a ChartKit region even if the CD is not inserted in your CD drive.

If you have more than one ChartKit CD, and you want to search for Marine Facilities in a CD region other than the
region that you are currently searching, you must tell Offshore Navigator to switch to the other CD's Marine
Facilities data.  To do this, choose Locate, Marine Facilities, and press the Setup tab.

Check and Highlight the Region File That You Want to Use
Each CD's Marine Facilities data is stored in a file named for the region covered.  (For example, the filename
"m_reg2.dat" indicates Marine Facilities data for ChartKit Region 2.) The Marine Facilities Setup window lists all
available data files, both Files on CD and Files Installed on Hard Drive.  From one of these lists, check and highlight
the file that you want to use.  Make sure that the file is not only checked, but also highlighted in blue.

(If you select a file from the Files On CD list, that file will be copied to your hard drive, for easy access in future use.
This ensures that any Marine Facilities data that you ever use will be on hand when you need it again.)

Select Display Options
The Marine Facilities in this list may be marked by symbols on the charts.
Display Marine Facilities:  Check here to show marine facilities as symbols on the charts.
Show Facility Labels:  The name of each facility will be shown next to its icon on the chart.
Match Label to Symbol Color:  The name of the facility will appear in the same color as its symbol.
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Press "Load Selected File" to Load the Marine Facilities Data
Once you have made your selections and are ready to load the database, press Load Selected File.  (Answer Yes
to the confirmation message.) The file that you selected will be ready for your use.

Note:  This Marine Facilities data will remain available until you specify a different Marine Facilities data file, or until
you start Offshore Navigator with a different CD in your drive.  (When a CD is present at Offshore Navigator
startup, its Marine Facilities data is automatically loaded for your use.  If you have more than one CD drive,
remember that Marine Facilities data will only be automatically loaded from the drive that was specified as the
default drive, during Offshore Navigator installation.)

Pictures (Aerial Photographs)

If you own a Maptech Coastal Navigation Photo CD, you can view a list the pictures it contains by choosing Pictures
from the Locate menu.  Highlight a photo name and press the Display button to view the photograph.

To see where the picture was taken, press Locate.  The location where the photo was taken will be marked by a
picture icon.  Whenever you see a camera icon on a chart, you can view a picture by right-clicking on the icon and
choosing Display.

To enlarge the picture, right-click on it and choose Enlarge.

The picture list may be sorted by Feature Name, Type, Lat/Lon, etc.- simply double-click the heading above a
column to rearrange the items in the list.  For details about the photo, press Info.  To copy the photograph to your
hard drive, press the Copy to HD button.
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A picture icon and its corresponding photograph.

Coastal Navigation Photo CDs are available in Maptech's Digital ChartKit package.  For more information, please
contact Maptech at (888) 839-5551 or visit www.maptech.com.

Connecting to the Internet

http://www.maptech.com/


133

This feature allows you to view web pages within Offshore Navigator.  Microsoft Internet Explorer is used as the
browser during Offshore Navigator operation.

To connect to a website, choose WWW Connection from the File menu, or press the Web button on the
toolbar.  In the window that appears, select from a list of preset websites, or check Type a website
(URL) to type the URL of any website that you want to visit.

You can add websites to your Favorites list.  To open a favorite website, highlight it and press Visit Favorite.  To
remove a website from your Favorites list, highlight it and press Delete Favorite.

Help Menu
 
To open the electronic Help document to the Table of Contents page, choose Contents from the Help menu, or
press the Help toolbar button (yellow question mark).  Choose Search from the Help menu to open the Help to the
Search tab, so you can type in the word or phrase you're looking for.
 
Other items available on Maptech ChartKit CDs edition 3.0 and higher include a guide to Chart Symbols commonly
found on NOAA nautical charts; the Coast Pilot publication, which includes information not found on charts (bridge
clearances, ice conditions, traffic separation schemes, etc.); Tide  and Current Stations and data sheets; Lights
lists, and Help documentation for Contour Professional software.  (See www.maptech.com for further information
on Contour Professional.)

http://www.maptech.com/
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CHAPTER 8:  ANNOTATION/MEASUREMENT TOOLS

Marks

Offshore Navigator lets you add symbols on the charts to indicate points of interest.  These symbols are called
Marks.  Several symbols are available for you to choose from, and you can label your marks with names.

Creating Marks
Press the Mark toolbar button, or choose Create Mark from the Tools
menu, and then click on the chart at the point you'd like to mark.
 

Position Marks (FULL VERSION ONLY)
Position Marks are marks you place at your current vessel location.  The position
mark stays behind on the chart after the vessel icon moves away.  Position marks
are handy for recording things you notice while you cruise, and for when you want
to make a quick note of where you were at a given time.  In the Mark List, Position
Marks are indicated by an asterisk (*).

To place a mark symbol on the chart at your vessel location, press the Position Mark toolbar button (or
choose Create Position Mark from the Tools menu).

Marks Setup

The options in the Marks Setup window help you decide how you want your marks to look.  Choose Marks, Mark
List from the Tools menu.  The Marks Setup window appears, with options for adjusting marks’ appearance and on-
screen display.
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Symbols
You can choose from several different symbols for your marks.
Pick a default symbol to use automatically each time you create
a mark.  You can edit your marks any time, and specify different
symbols for individual marks.
 

Color
A wide range of colors is available, to ensure that your marks
are visible against various chart backgrounds.  The color you
choose is applied to the mark symbol.  If you want, this color
can also be used for the text of the mark name (handy if you
have chosen to show mark names on the charts).
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Locating Marks
 

 
Choose Mark from the Locate menu or the Tools menu, for a list of all your marks.
Click on a mark in the list to go straight to its location on the chart.
 
You can also use this List window to delete marks from your mark list.  Highlight the
mark you want to delete, then press the Delete button.  This will remove the mark
from Offshore Navigator.  (To highlight all marks for deletion, press Select All.)

Annotations
 

Offshore Navigator lets you add short notes (annotations) to the chart image.  To add an annotation:
 
• Select the Annotation tool from the toolbar, or

• Choose Create Annotation from the Tools menu, or
• Right-click on the chart and choose Create Annotation.

 
The cursor will change to the annotation tool symbol (looks like a pen).  Click on the chart where you'd like to add
your annotation, and type your note in the window that appears.
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Deleting Annotations
To delete an annotation, right-click on it and choose Delete Annotation.

A2Bs
 

 

What is an A2B?

Offshore Navigator includes an A2B feature, letting you make quick measurements of the range and bearing
between any two points.  Use the A2B tool to click on the chart and set Point A and Point B.  The measurement data
stays on the chart until you hide or delete it.  (See page 137 for more on A2Bs.)
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A2Bs Setup

The A2Bs Setup window lets you control how the A2B tool works and looks.  Choose A2Bs from the Tools menu,
and select the Setup tab.

• Enable Borders and Range/Bearing:  A border will enclose the A2B line in a rectangle; a note along the
border line tells you the A2B's bearing.   Checking "Enable Borders and Range/Bearing" makes this feature
available for individual A2Bs that you select.  To use this feature for a particular A2B, right-click on the A2B
and choose Properties, then check Show Border and/or Show Range/Bearing.

• Display A2Bs:  When this is checked, your A2Bs will show on the charts.  Uncheck this option to
temporarily remove your A2Bs from display.

• Prompt for Symbol and Name:  Each time you create an A2B, Offshore Navigator will bring up a small
window in which you can type a name for your A2B, and choose from three available symbols for the A and
B points:

Locating A2Bs

Choose A2B from the Locate menu (or the Tools menu) to see a list of your A2B measurements, and choose one to
view on the screen.  You can also use this window to delete A2Bs from your list.
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Range/Bearing Lines (RBLs)
 

What is an RBL?

A range/bearing line, or "RBL" for short, is a straight line between the vessel and another point on the chart.  The
line is labeled with the range (distance) and bearing from the vessel to the line's endpoint.  You can create
range/bearing lines between the vessel and any location.
 

 

Creating an RBL

To create an RBL, simply right-click on the chart at the location to which you'd like to know the range and bearing,
and choose Add RBL.  A line will appear on the chart, connecting your vessel to the point where you clicked.  The
range and bearing are shown at the end of the line.  A window will appear, so you can give the RBL a name, write a
short note about it, and adjust other properties:
 

 
To view the properties (note, line color, etc.) of an RBL, right-click on the RBL's endpoint and choose Properties.
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RBL Setup
 

 
The RBL Setup window lets you tell Offshore Navigator how you want your RBLs to look and function.
 
Choose RBLs from the Tools menu and click the Setup tab in the resulting RBL window.  The "default RBL" section
lets you set options for Offshore Navigator to apply automatically to your new RBLs.  The "New RBL" section lets
you choose whether you want Offshore Navigator to use these default settings each time you create an RBL, or if
you want to be prompted to assign properties to each RBL individually when you create it.

Moving RBLs
As the vessel moves, the RBL will stay connected to the vessel, and the range and bearing numbers will
automatically update themselves.
 
You can also click-and-drag an RBL's endpoint (the end opposite the vessel) to different locations- for example, to
find range and bearing to various points on shore.
 

Deleting RBLs
To delete an RBL, right-click on its endpoint and choose Delete RBL.  Alternatively, you can choose RBLs, RBLs
from the Tools menu, and select the Manage RBLs tab.
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Finding RBLs

 

Choose RBLs from the Locate menu and the RBL window appears, opened to the List tab.  This window lists all your
RBLs (Range/Bearing Lines).

Each RBL has a checkbox next to it—when checked, the RBL is visible on the chart.  To temporarily remove an RBL
from view, uncheck this box.  (To temporarily remove ALL RBLs from view, press the Hide All button.  To restore
them all to the chart display, press Show All.)

To find a specific RBL on the chart, highlight it and press the Locate button.

To delete an RBL, highlight it and press Delete.
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RBL Properties

 
 
The RBL Properties window lets you adjust an RBL's settings, or read any notes you may have recorded.  For access
to the RBL Properties window, right-click on an RBL endpoint and choose Properties, or choose RBLs from the
Tools menu and select the RBL Properties tab.
 
 

Named Waypoints (FULL VERSION ONLY)
 

What is a Named Waypoint?

A Named Waypoint is a waypoint that can be used in multiple routes.  Named Waypoints are handy
for marking locations that you visit often.

 

Creating a Named Waypoint

To add a Named Waypoint to the chart, right-click and choose Create Named Waypoint.  The cursor will change
to a crosshair symbol.  Position the cursor at the location where you want to place the Named Waypoint, and click.
A Named Waypoint symbol will be added to the chart, and a window will appear on the screen, prompting you to
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enter a name, short name, and notes.  (If this window does not appear automatically, you can simply right-click on
the Named Waypoint and choose Properties to assign this information.)

Using a Named Waypoint in a Route

When you're creating a route and you want to use a Named Waypoint as the next point in your route, right-click
and choose Add Named Waypoint.  This will bring up a window listing all your Named Waypoints; choose the one
you want and press OK.  Your route will automatically connect to that Named Waypoint, and you can continue
adding regular waypoints after the Named Waypoint.  (The Named Waypoint is distinguished by a circle.)
 

Locating Named Waypoints

Choose Named Waypoints from the Locate menu or the Tools menu to view a list of your Named Waypoints.  To
view a Named Waypoint on the screen, highlight one from the list, and press the Locate  button to go straight to its
location on the chart.

The Visible column indicates whether each Named Waypoint is included in on-screen display, or whether it has
been temporarily removed from view.  (To restore a Named Waypoint to view, highlight its title in this list, press
Edit, and check the Display option.)
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Additional options provided:

• Edit:  Highlight a Named Waypoint, then press Edit to change its name, short name, icon, coordinate
location, or notes.

• Delete:  Deletes the highlighted Named Waypoint.
• Show All:  Ensures that ALL Named Waypoints are visible on the screen.
• Hide All:  Removes ALL Named Waypoints from  display.  (This does NOT delete them.  To restore them to

view, simply press Show All.)
• Print List:  As you might expect, this will provide a printed list of all your Named Waypoints.
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Named Waypoints Setup

The Setup tab lets you specify Properties settings to be used for any new Named Waypoints that you create.
Prompt for Named Waypoints Properties, when checked, means that the Properties window will automatically
appear each time you create a new Named Waypoint, so that you can immediately assign it a name, note, etc.
Uncheck this option if you do not want the Properties window to appear automatically upon Named Waypoint
creation.

• Display:  When Display is checked, ALL the Named Waypoints that you create will be included in the chart
display.

• Lock:  Locks the Named Waypoint into its location, so that it cannot be moved.  Since Named Waypoints
are designed to indicate specific locations and are not designed to be moved, the Lock option is always
checked and grayed out (unavailable for modification).

• Symbol:  The Named Waypoints symbol is available in three colors; select the one that you would like
Offshore Navigator to use when you create Named Waypoints.
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Named Waypoint Properties

 
To view a Named Waypoint's Properties, right-click on it and choose Properties.  The Properties window lets you
assign (or view) the name, short name (for GPS use), and lat/lon.  You can also choose a different-colored
symbol to use as this Named Waypoint's symbol.  Checking Display ensures that your Named Waypoint will be
visible on the chart.  Checking Lock prevents accidental clicking-and-dragging of the Named Waypoint.  Finally, the
Notes space lets you record comments about the point.

PNTMs (Personal Notices-to-Mariners)
 

What is a PNTM?

Offshore Navigator's PNTM (Personal Notices-to-Mariners) feature is modeled after the Notice to Mariners
publication distributed by NOAA (National Oceanic and Atmospheric Agency) each month.  If you own a Maptech
ChartKit Professional CD, your subscription to Maptech's Chart Update Service will let you automatically update your
electronic charts with all the latest NTM chart corrections.  If you aren't a ChartKit Professional user, you can
instead use PNTMs to mark chart features that have changed since the chart image was created, or any features of
personal importance to you in navigating.

Creating a PNTM

To create a PNTM, right-click on the chart at the location where you'd
like to create the PNTM, and choose Create PNTM.  You will be
asked to assign a title to the PNTM.  To adjust other PNTM properties,
right-click on the PNTM symbol and choose Properties.
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PNTM Properties

• PNTM Name, Comments:  You can assign a name to your PNTM, or use the default (the date of creation).  A
space is provided for you to record comments, if you wish.

• Action:  Use this to classify the chart changes made by your PNTMs.  What action does your PNTM change
take? Does it Add, Delete, Relocate, or Change the chart feature?

• Agency:  In NOAA's Notice-to-Mariners publication, each chart correction includes the agency responsible for
initiating the chart change.  Here, for a Personal Notice to Mariners, the Agency is set to User (you), but this
data field is available for your use if you want to change it.

• Chart ID, Edition:  The ID and edition number of the chart that contains this PNTM.
• Text Location:  Choose whether the text of the PNTM title should appear above, below, to the right, or to the

left of the PNTM icon.
• Symbol/Color:  Several symbols and colors are available; preview your selections in the display area provided

in the Properties window.
• Position Locked:  When Position Locked is checked, the PNTM symbol cannot be moved on the chart.  When

unlocked, the PNTM may be dragged with the mouse.
• Latitude/Longitude:  The coordinates of this PNTM.  If you want to change the PNTM location by typing new

coordinates here, first uncheck Position Locked.
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PNTM List/Locating PNTMs 

 
To go directly to a PNTM's location on the chart, double-click its title.  You can also use this PNTM List window to
delete selected PNTMs or print the entire list for reference.

The Setup tab lets you specify the settings you want Offshore Navigator to automatically use each time you create a
PNTM.  (See PNTM Properties for information on available settings.)
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Chapter 9:  POCKET CONTOUR

System Requirements

Pocket Contour software comes bundled with Offshore Navigator.  It is designed to let you view contour charts (see
page 46) on a Pocket PC handheld computer while navigating.  If you own a Pocket PC, you can install Maptech's
Pocket Contour software on any PDA equipped with the Microsoft Pocket PC operating system and an ARM SA1110
processor.  (See www.pocketpc.com for more information.)

Your Pocket PC must be connected to a GPS unit in order to perform realtime tracking.  The GPS unit must be able
to provide position data in NMEA 0183 format.  (Nearly all GPS units work with NMEA 0183; consult your GPS
manual or contact your GPS manufacturer for details if you are unsure about your receiver's specifications.)

Some GPS manufacturers, such as NAVMAN, produce sleeve-style GPS receivers that fit over the Pocket PC and
snap in place, connecting via the Pocket PC's COM port.  Standard handheld GPS receivers may be connected to a
Pocket PC via a serial patch cable, available from Maptech.  For more information on the NAVMAN sleeve-style GPS,
or the connecting serial cable for use with standard handheld GPS units, visit www.maptech.com.

Installing Software and Charts

Installing Pocket Contour on Your Pocket PC

To install the program, connect your Pocket PC to your desktop computer, then from Offshore Navigator's View
menu, choose Options, Contour Charts and press the Install Pocket Contour button.

Installing Charts on Your Pocket PC

1. Connect your Pocket PC to your desktop and start Offshore Navigator.
2. In Offshore Navigator, open the contour chart that you'd like to copy to your Pocket PC.  (Requires first opening

a nautical chart for the area, then choosing Link to Contour Chart from the Charts menu.)
3. Click on the contour chart window's title bar, to highlight the window (making it the active window).
4. From Offshore Navigator's Charts menu, choose Send Contour Chart to PDA.  Follow the instructions on the

screen.
5. Once the transfer is complete, the chart will be available for use in Pocket Contour on your Pocket PC.  (You

may need to restart Pocket Contour in order to see the newly copied chart.)

Removing Charts from Your Pocket PC

In your Pocket PC, tap Start, Programs, File Explorer.  Use the down arrow to highlight My Device.  Tap the
Program Files folder, then the Contour folder, then the 3DCharts folder.  This is where your contour chart files
are stored.  Hold the stylus against the files you want to remove, and choose Delete.

Toggling Between Pages

Press the Page button to toggle between the three screens, or Pages, of Pocket Contour.

http://www.pocketpc.com/
http://www.maptech.com/


150

The Contour Chart Page

Charts and Vessel

The Contour Chart Page shows your vessel position in relation to the
surrounding underwater contours and land formations.  The darker
the color, the deeper the water.  Land is shown as light tan.

If no chart coverage is available for the location indicated by your
GPS signal, OR if your GPS has not yet established your position, the
screen will read "No Chart Coverage."

Your vessel is represented by a red arrow-shaped icon.  The
point of the arrow represents the bow of your vessel.  The
approximate depth at your location is noted at the top left

corner of the screen.  (To change the units of depth measurement,
tap Options, Units, Depth.) The line extending downward from the
vessel helps you visualize your location in relation to the contours.

Viewing Angle

You can adjust the angle at which you're viewing the contour chart.  Press the Lock button to lock the chart
into a different viewing angle.  You can choose between three views:  over the right shoulder, over the left

shoulder, and straight ahead.  (Pressing the Lock button toggles between these three angles.)

In addition, you can temporarily adjust the chart angle by dragging your stylus across the chart image.  Think of
this as taking hold of the foreground of the chart, and rotating/tilting the chart to your liking.  When you stop
moving the stylus, the chart will remain for several seconds in the position that you have chosen, so you can look
around.  After this delay, the chart will automatically return to the Locked viewing angle.

Moving In and Out (Contour Page)

Tap the Plus button to move in for a closer view of the contour chart.

Tap the Minus button for a wider view of the area.

Vertical Exaggeration

Sometimes it is helpful to adjust the vertical exaggeration.  For example, in a relatively flat area, you may wish to
increase exaggeration to emphasize the rises and dips of the terrain.  Or, in an area with many peaks and valleys
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close together, you may find it easier to "flatten" the terrain and view your vessel against a more moderate
backdrop.

To increase the vertical exaggeration (making hills taller and valleys deeper), press the button that shows a
tall mountain and an Up arrow.

To decrease exaggeration (flattening the landscape), press the button with the shorter mountains and a Down
arrow.

Creating Hotspots (Contour Page)

You can mark points of interest by adding hotspots to the chart.  A hotspot is shown as a
red dot, with a depth line extending downward to the bottom.

When you come across something you want to mark, press the Hotspot button
to place a hotspot on the chart at the location of your vessel.  The hotspot
symbol will remain on the contour chart to represent your point of interest.

To rename, delete, or set course for a hotspot, press the Page button until you reach the Map Page.

The Map Page

Vessel Orientation

The Map page symbolizes your approximate location as though
viewed from above.  (As in all three Pages of Pocket Contour,
your charted depth is noted in the top left corner of the
screen.)

Your vessel is represented by a red circle/crosshair symbol, with an
arrow pointing in the direction you're traveling.

To adjust vessel orientation, tap Options, Orientation:

- North Up:  In this mode, north is represented by the top of your
Pocket PC screen.  As your direction changes, the vessel arrow will
likewise rotate on the screen.  For example, if you are headed east,
the vessel arrow will be pointed to the right.  (When you first start
using Pocket Contour, your vessel is shown in North Up orientation.)
- Course Up:  Your vessel arrow will always point towards the top of
the screen, regardless of your direction of travel.  This mode mirrors
your actual surrounding:  For example, if you're headed west, the top
of the screen represents west (mirroring your view from the helm).
If there are hotspots south of your location, they will be shown on
the left side of the Pocket PC screen.  Because it corresponds
spatially to your actual surroundings, Course Up mode may help you
visualize your location in relation to any hotspots you may have
created.

Zooming In and Out (Map Page)
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To zoom in for a closer view, press the Plus button.

To zoom out for a wider view of the area, press the Minus button.

The number at the bottom of the screen tells you the width of the area being shown on the screen.  If you zoom in,
this number will get smaller, since less area will be shown.  If you zoom out, the number will get bigger since you're
looking at more area.  (Tip:  If you don't see your hotspots on the Map Page, try zooming out.)

Creating Hotspots (Map Page)

You can mark points of interest by adding hotspots, or symbols, to the chart.  When you press the Hotspot
button, a symbol is placed on the screen at your vessel location.  As your vessel moves away from this

location, the hotspot stays in place, marking your point of interest.

You can create hotspots when you're viewing the Map Page OR the Contour Chart Page.  On the Map Page,
your hotspots are shown as green squares.  On the Contour Page, they are shown as red labels.

To get details about any hotspot on the Map Page, just tap the green hotspot symbol with your stylus.  A popup
window will appear, with the hotspot's name, the bearing and distance from your vessel to the hotspot, and GOTO
option.

Goto Hotspot

Tap a hotspot and select Goto!, and Pocket Contour will guide you to that hotspot's location.

In this example, 337° is the bearing to the hotspot, 36° steer L is the number of
degrees to steer (left), 409 feet is the distance to the hotspot, and 3.2 knots is the
vessel's present speed.  These figures will be updated as you move.

The Goto figures will remain at the top of the screen even if you toggle to a
different Page.  When you reach the hotspot—or if you decide to abandon course
for it—you can remove these figures from view by tapping the Hotspot button,
which is relabeled Quit Goto.

Deleting Hotspots

To delete a hotspot, tap it and choose Delete.  To delete ALL your hotspots and start with a "clean slate," tap
Options, Clear All Hotspots.  ALL of your hotspots will be permanently deleted.

The GPS Page

Position Data
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The GPS Page tells you your latitude and longitude, along with your
COG (Course Over Ground) and your SOG (Speed Over Ground).
When your GPS is receiving a valid satellite signal and providing
accurate position data, this data is shown in green type.  When red
type is shown, this indicates invalid data or loss of signal (you may
also see a message, like "Waiting for GPS").  Once a valid signal is
received, the data will change back to green type.  The GPS Page
also tells you how many satellites your GPS unit is tracking at any
given time.

GPS Setup

On the GPS Page, tap Options, GPS Setup.  In the resulting
window, select the Port where your GPS is connected to your Pocket
PC.  (If you aren't sure which port you're using, check your Pocket
PC's User Manual.)

Signal strength, position accuracy, and data update frequency differ
between GPS units.  In order for Pocket Contour to track your
movements as efficiently as possible, you should adjust your GPS
Input Sensitivity.  This controls the precision of your
latitude/longitude data, and therefore the accuracy and speed at
which your vessel icon is placed on the screen.  You should base your
GPS Sensitivity setting on your activity level:

- Use High when you're anchored, so that Pocket Contour will
recognize subtle movements while drifting.
- Use Low when you're moving at high speed, when extreme
precision is unnecessary (and might slow down vessel display update
time).
- Leave this setting at Normal the rest of the time.

At Normal sensitivity, your vessel icon will generally be placed within
3-5 feet of your actual location.  Anything more precise is
unnecessary during high speed travel.  By contrast, you can benefit

from greater accuracy at anchor, when it is important to monitor smaller movements.

Units of Measurement

Tap Options, Units to adjust units of measurement for the following:
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- Position:  This setting affects the display of your vessel's latitude and longitude coordinates.  Choose Decimal
Degrees (DDD.DDDDDD), Degrees/Minutes/Seconds (DDD MM SS), or Degrees and Decimal Minutes (DDD
MM.MM).
- COG:  Choose whether your Course Over Ground should be measured from True North or Magnetic North.
- SOG:  Your Speed Over Ground may be reported in Statute Miles, Kilometers, or Knots.
- Depth:  Depth may be shown in Fathoms, Meters, or Feet.  This setting affects the depth display at top left of the
Pocket Contour screen.
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Chapter 10:  QUESTIONS AND ANSWERS

Routes

I want to follow a route, but the vessel isn't moving.
It sounds like you've already chosen the route and given the Follow command (right-click on a waypoint and choose
Follow).   The vessel isn't moving because you haven't chosen a Position Source.  From the Vessel/GPS menu,
choose either Position from GPS, or Position from Simulator.

If you're using Simulator mode, and vessel still isn't moving (or is moving in the wrong direction), choose Setup,
Simulator from the Vessel/GPS menu.  Assign a different vessel heading (if the Heading field is grayed out, check
Also apply vessel data, which will allow you to edit the Vessel Speed and Heading fields.)

How do I include a Named Waypoint in a route?
You can add a Named Waypoint while you're creating a route:  just right-click and choose Add Named Waypoint,
then select the Waypoint from the resulting list and press OK.  The Named Waypoint will be inserted into the route.

If you have already created the route, you can still add a Named Waypoint to it.  Right-click on the route and
choose Insert Waypoint (In Line, At Beginning, or At End), then right-click again and choose Add Named
Waypoint.  Select the Named Waypoint from the resulting list, and press OK.

Can I move waypoints in the route that I'm following?
Yes.  Just hold the cursor over the waypoint, and click-and-drag to move it to a new location.  (If you aren't able to
"grab" the waypoint, it means the waypoint's position is locked.  To unlock it, right-click on the route and choose
Route Properties, then under the Display tab, uncheck Lock.  You will now be able to drag the waypoint.)

How do I add waypoints to a route I've already created?
Insert Waypoint at Beginning:

1. Right-click anywhere on the route and choose Insert Point at Beginning.  The cursor will change to the
Route tool, ready to set a waypoint.  A line stretches from the route's first waypoint and follows the cursor as
you move.

2. Left-click to set new waypoints.
3. When finished, right-click and choose Done.

Insert Waypoint at End:
1. Right-click anywhere on a route and select Insert Point at End.  The cursor will change to the Route tool,

ready to set a waypoint.  A line stretches from the route's last waypoint and follows the cursor as you move.
2. Left-click to set new waypoints.
3. When finished, right-click and choose Done.

Insert Waypoint in Middle:
1. Right-click at the place where you want to add the waypoint, and select Insert Waypoint in Line.
2. The waypoint will appear where you clicked.  You can use the mouse to drag the waypoint if you need to move

it (or any other waypoint).
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How can I change a waypoint's symbol?
Single Waypoint:
1. Right-click on the waypoint and choose Route Waypoint Properties.
2. The Waypoint Properties window appears, with the symbol, color, name, etc.  for this waypoint.  Press Change

and select a different symbol, then press OK when you have made your changes.
3. The new symbol is present on the chart.

All Waypoints in a Route:
1. Right-click anywhere on the route and choose Route Properties.
2. Under the Display tab, press the Change button next to the waypoint Icon.  Select a different symbol, and press

OK to close the window(s).
3. The new symbol is used for each waypoint of the route.

How do I delete a waypoint from a route?
Single Waypoint:
Right-click on the waypoint and choose Delete this Point.

Several Waypoints:
1. Right-click on the route and choose Route Properties, or choose Routes from the Routes menu and double-click

the name of the route.  (Either will open the Route Properties window.)
2. Select the Points tab.
3. Highlight a waypoint and press Delete.  Continue until you have deleted all that you want to.
4. Press OK and close the Route Properties window.  The waypoints have been removed from the route.

Vessel

I'm using the Simulator to follow a route.  Is there any way to speed up the vessel?
Yes.  From the Vessel/GPS menu, choose Setup, Simulator, and use the Time Compression lever to adjust the
speed of the simulation.  This won't affect your cruising speed or maximum speed settings, but it will decrease the
time that it takes to simulate movement on the chart.  (Think of it like watching a videotape in fast-forward.) Note:
Try a low setting at first.

How do I place the vessel at a specific location?
Just right-click where you want the vessel to be, and from the resulting menu, choose Put Vessel Here (near
bottom of menu).

I lost track of the vessel icon; how can I get it back again?
If you want to find the vessel, press the Locate Vessel button (on the left side of the toolbar), or choose Vessel
from the Locate menu.

If you want to put the vessel in a particular location, right-click on the chart and choose Put Vessel Here.

To keep your vessel in view on the screen, check the Follow Vessel checkbox at the bottom of the chart window.
See page 20 for details.
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How can I keep the vessel icon on the screen during navigation?
To keep the vessel from straying out of sight, check the Follow Vessel option in the Navigation Panel at the
bottom of your screen.  This way, Offshore Navigator will follow the vessel as it moves along its course.  (See page
23 for details on the three vessel-to-chart orientation options.)

For some leeway to scroll away from the vessel and explore surrounding areas, choose View, Options, General
and check Allow Temporarily Scrolling away from Vessel.  This will let you scroll away from the vessel location
for a few seconds at a time, before Offshore Navigator automatically restores the vessel view.  This is handy for
scouting out the area ahead, without breaking the Follow Vessel command.

GPS Connection

What hardware do I need for the GPS connection?
Successful communication with a GPS unit requires a variety of hardware and software connections.  Therefore, the
first step is to ensure that you have the proper equipment.  There are three pieces of equipment required to
connect a GPS unit to your computer.  These are:

1.  A compatible GPS unit.
2.  A data cable (available from your GPS manufacturer).
3.  An available COM port.

Where do I get a GPS cable?
GPS-to-computer cables are only available from your GPS manufacturer.  Typically, cables can also be bundled with
software provided by the GPS manufacturer.  (Although it is not required for communication with Offshore
Navigator, that GPS manufacturer-supplied software can be useful in diagnosing problems connecting to your GPS
unit.)

What's a COM port?
A serial communications (or COM) port is a connector in the back of a computer that enables serial devices (like a
mouse or an external modem) to communicate with the computer.

Most computers provide at least two external COM ports, COM 1 and COM 2.  (Your mouse may be connected to
one of these.) Consult your computer's documentation to determine if you have an available COM port.

My COM Port is 25-pin but my GPS cable has a 9-pin connector.  Can I get an adaptor?
Yes.  Computer supply stores should carry an adaptor.

My Computer does not have a 9-pin COM Port, but does have a USB serial port.  Can I
get an adaptor?

Yes.  Computer supply stores should carry an adaptor. Be sure to also install the driver software that accompanies
the adaptor, otherwise it will not be recognized by your computer's operating system.

I have set up my GPS unit, but I get an error message when I try to connect.
First, try running the GPS Setup Wizard (click Vessel/GPS, Setup, GPS Setup Wizard).  The Wizard will likely
detect the problem and suggest a solution.  If you still get an error when you give a GPS command, the next step is
to verify that your connection is physically sound and that your equipment (computer, GPS, and data cable) is
working properly.  You can use a standard Windows accessory called HyperTerminal to check this.
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Using HyperTerminal to Check your Equipment Connection
First, close Offshore Navigator.  Next, set your GPS unit to NMEA output.  (Garmin users:  choose NMEA/NMEA from
the GPS's Setup Menu.  Magellan users:  choose NMEA 0183 2.0 from the NMEA menu.  Refer to your GPS unit's
manual for instructions if necessary.)

Next, start HyperTerminal.  From the Windows Start button, choose Programs, Accessories,  Communications, and
HyperTerminal (the application, not the group/folder).  (If you do not have HyperTerminal installed, see below for
installation instructions.) If a window comes up asking if you want to configure a modem now, answer No or Cancel.

The Connection Description window should now appear.  Type in "Test" for the connection's Name and press OK.

The next window is the Phone Number window.  For Connect Using, select Direct to COM1 and press OK.  In COM1
Properties, change the Bits per Second from 2400 to 4800 (since the NMEA 0183 standard specifies 4800 baud
rate) and press OK.

At this point, one of three things can happen:

1.  I get an error message.
This means that the COM port you have selected is either unavailable, or is not functioning properly.  You may
have inadvertently specified the wrong COM port name.  Close HyperTerminal and repeat the procedure, trying
a different COM port this time.  If you are sure that you are selecting the proper COM port and calling it by its
correct name, that COM port may be defective.  Contact your computer manufacturer for further
troubleshooting tips.

2.  I get a blank screen with a flashing cursor.
This means that the COM port you have chosen is not receiving NMEA data.   Close the HyperTerminal data
window and repeat the process, trying a different COM port.   If you are certain that you are selecting the
proper COM port, there is something wrong with either your COM port, your data cable, or your GPS unit.
Since the problem lies outside of Offshore Navigator, you should contact your computer or GPS manufacturer
for further troubleshooting tips.

3.  I get a screen with text scrolling upward.
You are successfully connected to your GPS unit!  The data that you see scrolling by are the NMEA sentences
coming from your GPS.  Note the COM port that you used for this successful test, and exit HyperTerminal.
(When asked if you want to disconnect now, answer Yes.  When asked if you want to save session "Test,"
answer No.)

Now that you have determined the correct COM port, start Offshore Navigator.  Leave your GPS unit in NMEA mode
for a moment.  In Offshore Navigator's GPS Setup window, choose NMEA - Generic for Manufacturer, choose NMEA
0183 2.1 for Unit, choose the correct COM port, and press OK.  Check GPS On.  Close the GPS Setup window, and
you should find a checkmark next to the GPS On option in the GPS menu.  The checkmark indicates that
communication has been established between Offshore Navigator and your GPS.  You should now be able to change
your GPS You should now be able to set your GPS back to its native mode (i.e., from NMEA to GRMN/GRMN for
most Garmin users), change the GPS Setup settings to match your unit, and choose GPS On again.  Everything
should now be working properly.

I can't get HyperTerminal to display any data (NMEA sentences).
If you have followed the connection procedure explained in the last section, and if you have tried each COM port,
then there is something wrong with either your COM port, your data cable, or your GPS unit.  Since the problem is
outside Offshore Navigator, you should contact your computer or GPS manufacturer for further troubleshooting tips.

I can't find HyperTerminal.  How do I install it on my machine?
HyperTerminal is a standard Windows application that is included with all modern versions of Windows.  If it is not
installed on your computer, open the Windows Control Panel, choose Add/Remove Programs, select the Windows
Setup tab, click on Communications and press Details.  Turn on the check box for HyperTerminal and press OK,
then OK again.  (You may need your Windows CD to complete the installation.)
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I believe my COM port is working properly, but I still can't connect.
If you have already used HyperTerminal to verify your connection, and you believe the COM port connection is
sound, but you're still unable to connect to Offshore Navigator, here are a few more suggestions for you to try.

1.  Ensure that your GPS unit has the latest manufacturer's "software."
Your GPS unit is actually a miniature computer, containing built-in software that controls all of the unit's
functions - including communication.  Contact your GPS manufacturer to ensure that you are using the latest
version of their software.  (Software updates are often available from the GPS manufacturer's website.)

2.  Try getting a satellite lock.
Sometimes, a GPS unit will not communicate properly until it has a good position fix.   Try operating the GPS
unit near a window or initializing it outdoors before attempting to transfer data.

3.  Try other GPS software.
If you own other GPS-enabled software (or if you received software from the manufacturer when you
purchased your GPS cable), try connecting to your computer with that software.  If you are unable to connect
using any available software, the problem is most likely equipment-related (COM port, data cable, or GPS unit).

4.  Check your cable.
Defective cables can also be the source of trouble.  If you made your cable yourself, ensure that the proper
pins are being used and the soldering is sound.  The wires should be spliced together as follows:

GPS COMPUTER

Data Out (Send) Data In (Pin 2, Receive)

Data In (Receive) Data Out (Pin 3, Send)

Ground Ground (Pin 5, Ground)

If you can connect when NMEA - Generic is selected under Manufacturer (in Offshore Navigator's GPS Setup
window), but not when you select your particular GPS make and model, your cable may be transmitting data from
the GPS unit but not receiving data from the computer.  Check your cable and COM port for problems.

Charts

When scrolling to the edge of a chart, is there a quick way to open a chart for the
adjacent area?

Yes- hold the cursor at the very edge of the chart until it turns into an arrow symbol, then double-click open the
adjacent chart.   (The chart you were previously viewing will close).

Is it possible to adjust the chart scrolling speed?
Yes.   Choose View, Options, Chart Display, and slide the Chart Scrolling Speed lever to adjust the scrolling
speed.

Note:  Another way to increase scrolling speed is to try switching to 16-bit color (decreasing color resolution from
32-bit to 16-bit).   Use the Windows Control Panel to adjust this Display setting (from the Start menu, choose
Settings, Control Panel, Display, Settings, Colors).   You may also try 256 Colors if necessary.
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Datum

What is datum?
Simply put, datum is a model used for calculating the location of the Earth's center.  This center calculation is used
as a reference point in establishing coordinate locations, like latitude/longitude, on the Earth's surface.

Why does it matter?
There are many different datums.  A coordinate location calculated using one datum may differ by several hundred
feet from the same coordinates calculated from another datum.  Therefore, before relying on coordinate location
information, it is important to know what datum was used in establishing those coordinates.

See page 92 for more information.

Toolbar, Menus and Control Panels

Can I rearrange the toolbar and/or control panels?
Temporarily Removing Control Panels
The top portion of the View menu contains several items with checkboxes.   These are components of Offshore
Navigator's main window.  You may temporarily hide components from view in order to create more screen space
for chart display.  Simply uncheck an item to remove it from view.  Use the View menu again to restore that item to
view.  In this way, you can show or hide the Navigation Panel, Tool Bar, Status Bar, Chart View Status Bar,
Overview Window and/or Data Windows.

Moving the Toolbar
The toolbar, which usually runs across the top of the screen, may be moved to another location within the Offshore
Navigator window.   Simply place the cursor in a gray area between toolbar buttons, and drag in the direction you'd
like to move the toolbar.   A rectangular outline will follow your cursor, representing the toolbar.

If you hold the cursor up against the side of the window for a moment, the rectangle will become vertical.  Release
the mouse button, and the toolbar will be aligned vertically on the side of the chart window.

If you release the mouse button in the middle of the chart window, the toolbar will "float" in its own window.

(You can use this same drag-and-drop method to return the toolbar to its original place.)

How come my toolbar looks different than the images in the Help pages?
Your toolbar is probably set to show smaller buttons.  For full display of all available buttons, choose View,
Options General, and check the Large Toolbar Buttons option.

Another possibility is that Offshore Navigator is in On-Water Mode, which uses a simplified toolbar for efficient
navigation (see page 96).  Press Plan to return to Plan Mode (Offshore Navigator's standard operating mode).

Printing

I want the chart to print sideways (so the printout is wider than it is tall).
This requires setting the Paper Orientation to "Landscape."  There are two ways you can do this:



161

• Choose Print Setup from the File menu, and set Paper Orientation to Landscape.   This will affect the
next print job you send from Offshore Navigator, but you will need to reset the Paper Orientation again
each time you want another Landscape printout.

• To avoid having to specify Landscape each time you want to print, you can instead adjust the paper
orientation setting in the Windows Control Panel.   This will affect everything you print with that
particular printer.   From the Start menu, choose Settings, Printers.  Right-click on the printer you're using,
and choose Properties.  You can then set Paper Orientation to Landscape.

I want to print a chart without any routes, marks, or other overlays showing.
If it isn't showing on-screen, it won't show in a printout, so the thing to do is remove the overlays from display.   To
temporarily remove ALL overlays of a certain type, choose Options from the View menu, select the Overlays tab,
and under Show, uncheck Routes, Marks, etc.

To temporarily hide individual overlays on the chart, right-click on the overlay itself and choose Properties, then
uncheck the Display checkbox.   (Or use the Routes List, Marks List, etc., to single out the overlays that you want to
remove.)

To restore your overlays to view, just re-check their Display option(s).

I want to make a printout that only shows what I'm looking at on the screen.
 Choose Print from the File menu for a one-page printout of the chart area you're viewing, plus some additional
coverage as necessary to fill the paper.   (To print more of the chart, choose Print Chart Packet and select the
area(s) you want.)

 

Alarms (FULL VERSION ONLY)

Can I change the sound used for Auditory Alarms?
The alarm sound can be modified in the Windows Control Panel.   Click Start on your Windows taskbar, and choose
Settings/Control Panel.   In the Control Panel, double-click the Sounds icon.   The Auditory Alarm sound is the same
sound set for Exclamation.   You can sample different sounds here and pick one that you like.

The Anchor Alarm keeps sounding; how can I deactivate it?
If the Anchor Alarm is sounding at times when you don't need it to, you can delete it.   Choose Alarms from the
Tools menu, highlight the Anchor Alarm in the list, and press Delete.   (Remember to create a new Anchor Alarm
when you do set anchor.)

A2Bs
I would like to include range/bearing data on my A2B lines, but that option is always
grayed out.

If you would like to be able to include range/bearing data (or borders around your A2Bs), choose A2Bs from the
Tools menu and check the option to Enable Borders and Range/Bearing.

Can I create an A2B measurement across multiple charts?
The A2B tool will work across charts, and is a handy way of finding straight-line distance ("as the crow flies").
Select the A2B tool from either the toolbar or the Tools menu, then click to set point A.   Open the chart containing
point B, and click again.   Right-click on the A2B and choose Properties to read the range and bearing data.
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Miscellaneous

What are the minimum system requirements for running Offshore Navigator?
The Minimum System Requirements for running Offshore Navigator are:

• Windows 98, ME, NT, 2000 or XP operating system
• Pentium-class CPU
• 32 MB memory
• 256 Color Palette
• 800 x 600 Desktop Area
• 100 MB free Disk Space
• Internet Explorer 4.0

What chart formats does Offshore Navigator support?
Offshore Navigator is compatible with the following chart/map formats:

• Maptech/BSB (editions 2.x, 3.x, 4.x, and 5.x)
• Maptech/PCX
• Resolution Mapping RML
• Maptech Navigation Photos
• Maptech Topographic Maps/Terrain Navigator
• Maptech AeroPacks (Aeronautical Charts)
• Maptech Contour Professional (Edition 4.0)
• Fugawi/BSB (Edition 1)
• NDI/BSB (Edition 2.1 or later)

How to Contact Maptech
 
If you have a question and you haven't found the answer here in the Help pages, Maptech's technical support staff
will be happy to assist you.  Support is available from 8:30AM to 5PM Eastern Time, Monday through Friday:
 

E-mail:  support@maptech.com
Fax:  (978) 792-1095
Internet:  http://www.maptech.com/support

 
Maptech's support site includes an interactive question-and-answer wizard, as well as an online technical support
discussion forum, where Maptech software users and technical support staff can share information, suggestions and
comments.
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